
www.infineon.com

请注意赛普拉斯已正式并入英飞凌科技公司。
此封面页之后的文件标注有“赛普拉斯”的文件即该产品为此公司最初开发的。请注
意作为英飞凌产品组合的部分，英飞凌将继续为新的及现有客户提供该产品。

文件内容的连续性
事实是英飞凌提供如下产品作为英飞凌产品组合的部分不会带来对于此文件的任何
变更。未来的变更将在恰当的时候发生，且任何变更将在历史页面记录。 
 
订购零件编号的连续性
英飞凌继续支持现有零件编号的使用。下单时请继续使用数据表中的订购零件编号。  



CY8CKIT-062-WiFi-BT

PSoC 6 WiFi-BT Pioneer 套件指南

文档编号 : 002-28216 Rev. **

Cypress Semiconductor
198 Champion Court

San Jose, CA 95134-1709
www.cypress.com

http://www.cypress.com
http://www.cypress.com


版权所有
版权所有

© 赛普拉斯半导体公司， 2018-2019 年。本文件是赛普拉斯半导体公司及其子公司，包括 Spansion LLC （“ 赛普

拉斯 ”）的财产。本文件，包括其包含或引用的任何软件或固件（“ 软件 ”），根据全球范围内的知识产权法律以及

美国与其他国家签署条约由赛普拉斯所有。除非在本款中另有明确规定，赛普拉斯保留在该等法律和条约下的所有
权利，且未就其专利、版权、商标或其他知识产权授予任何许可。如果软件并不附随有一份许可协议且贵方未以其
他方式与赛普拉斯签署关于使用软件的书面协议，赛普拉斯特此授予贵方属人性质的、非独家且不可转让的如下许
可（无再许可权）（1）在赛普拉斯特软件著作权项下的下列许可权（一）对以源代码形式提供的软件，仅出于在

赛普拉斯硬件产品上使用之目的且仅在贵方集团内部修改和复制软件，和 （二）仅限于在有关赛普拉斯硬件产品
上使用之目的将软件以二进制代码形式的向外部最终用户提供（无论直接提供或通过经销商和分销商间接提供），
和 （2）在被软件 （由赛普拉斯公司提供，且未经修改）侵犯的赛普拉斯专利的权利主张项下，仅出于在赛普拉

斯硬件产品上使用之目的制造、使用、提供和进口软件的许可。禁止对软件的任何其他使用、复制、修改、翻译或
汇编。  

在适用法律允许的限度内，赛普拉斯未对本文件或任何软件作出任何明示或暗示的担保，包括但不限于关于适销性
和特定用途的默示保证。没有任何电子设备是绝对安全的。因此，尽管赛普拉斯在其硬件和软件产品中采取了必要
的安全措施，但是赛普拉斯并不承担任何由于使用赛普拉斯产品而引起的安全问题及安全漏洞的责任，例如未经授
权的访问或使用赛普拉斯产品。此外，本材料中所介绍的赛普拉斯产品有可能存在设计缺陷或设计错误，从而导致
产品的性能与公布的规 格不一致。（如果发现此类问题，赛普拉斯会提供勘误表）赛普拉斯保留更改本文件的权

利，届时将不另行通知。在适用法律允许的限度内，赛普拉斯不对因应用或使用本文件所述任何产品或电路引起的
任何后果负责。本文件，包括任何样本设计信息或程序代码信息，仅为供参考之目的提供。文件使用人应负责正确
设计、计划和测试信息应用和由此生产的任何产品的功能和安全性。赛普拉斯产品不应被设计为、设定为或授权用
作武器操作、武器系统、核设施、生命支持设备或系统、其他医疗设备或系统（包括急救设备和手术植入物）、污
染控制或有害物质管理系统中的关键部件，或产品植入之设备或系统故障可能导致人身伤害、死亡或财产损失其他
用途 （“ 非预期用途 ”）。关键部件指，若该部件发生故障，经合理预期会导致设备或系统故障或会影响设备或系

统安全性和有效性的部件。针对由赛普拉斯产品非预期用途产生或相关的任何主张、费用、损失和其他责任，赛普
拉斯不承担全部或部分责任且贵方不应追究赛普拉斯之责任。贵方应赔偿赛普拉斯因赛普拉斯产品任何非预期用
途产生或相关的所有索赔、费用、损失和其他责任，包括因人身伤害或死亡引起的主张，并使之免受损失。

赛普拉斯、赛普拉斯徽标、Spansion、Spansion 徽标，及上述项目的组合，WICED，及 PSoC、CapSense、EZ-
USB、 F-RAM 和 Traveo 应视为赛普拉斯在美国和其他国家的商标或注册商标。请访问 cypress.com 获取赛普拉

斯商标的完整列表。其他名称和品牌可能由其各自所有者主张为该方财产。
PSoC 6 WiFi-BT Pioneer 套件指南, 文档编号: 002-28216 Rev. ** 2



目录
1. 简介 6

1.1 套件内容 ......................................................................................................................7
1.2 硬件简介 ......................................................................................................................8

1.2.1 CY8CKIT-062-WiFi-BT板详细信息 ...................................................................8
1.2.2 CY8CKIT-028-TFT电路板详细信息 ................................................................10

1.3 软件介绍 ....................................................................................................................11
1.3.1 PSoC Creator概述..........................................................................................11
1.3.2 WICED Studio开发系统概述 ..........................................................................13

1.4 入门............................................................................................................................15
1.5 额外学习资源 .............................................................................................................15
1.6 技术支持 ....................................................................................................................15
1.7 文档规范 ....................................................................................................................16
1.8 缩略语 ........................................................................................................................16

2. PSoC Creator 18

2.1 开始之前 ....................................................................................................................18
2.2 安装套件软件 .............................................................................................................18
2.3 使用PSoC Creator编程和调试 ...................................................................................21
2.4 套件代码示例 .............................................................................................................21

2.4.1 使用PSoC Creator中内置的套件代码示例......................................................21

3. WICED 24

3.1 介绍............................................................................................................................24
3.2 开始之前 ....................................................................................................................24
3.3 安装WICED................................................................................................................24
3.4 WICED中的编程和调试..............................................................................................25

3.4.1 在WICED Studio IDE中为CY8CKIT-062-WiFi-BT构建和编程项目.................25
3.4.2 使用断点调试项目 ..........................................................................................29

3.5 套件代码示例 .............................................................................................................33
3.5.1 在WICED Studio IDE中构建和编程项目.........................................................33

4. 套件硬件 38

4.1 CY8CKIT-062-WiFi-BT详细信息 ................................................................................38
4.2 CY8CKIT-028-TFT详细信息 ......................................................................................50

4.2.1 CY8CKIT-028-TFT显示屏蔽 ...........................................................................50
4.3 KitProg2 .....................................................................................................................53

4.3.1 简介 ................................................................................................................53
4.3.2 使用PSoC Programmer编程 ..........................................................................53
4.3.3 KitProg2的套件枚举和编程模式 .....................................................................53
4.3.4 USB-UART桥接..............................................................................................54
4.3.5 USB-I2C桥接..................................................................................................55
4.3.6 USB-SPI桥接..................................................................................................55
PSoC 6 WiFi-BT Pioneer 套件指南, 文档编号: 002-28216 Rev. ** 3



4.4 EZ-PD CCG3 Type-C电力传输 ..................................................................................56

A. 附录 58

A.1 原理图 ........................................................................................................................58
A.2 硬件功能描述 .............................................................................................................58

A.2.1 PSoC 6 MCU (U1)..........................................................................................58
A.2.2 PSoC 5LP (U2) ..............................................................................................58
A.2.3 PSoC 5LP和PSoC 6 MCU之间的串行互连 ....................................................59
A.2.4 EZ-PD CCG3供电系统 ...................................................................................60
A.2.5 供电系统.........................................................................................................61
A.2.6 扩展连接器 .....................................................................................................64
A.2.7 CapSense电路 ...............................................................................................65
A.2.8 LED ................................................................................................................65
A.2.9 按压按钮.........................................................................................................66
A.2.10 赛普拉斯NOR闪存..........................................................................................66
A.2.11 WiFi和蓝牙模块 ..............................................................................................67
A.2.12 USB主机和USB设备连接 ...............................................................................68

A.3 PSoC 6 WiFi-BT Pioneer板修改 ................................................................................69
A.3.1 编程和调试接头上的旁路保护电路 (J11) ........................................................69
A.3.2 PSoC 6 MCU用户按键 (SW2) ........................................................................70
A.3.3 SWD连接器插座 (J29)....................................................................................70
A.3.4 CapSense屏蔽 ...............................................................................................70
A.3.5 CSH................................................................................................................71
A.3.6 锂电池充电器..................................................................................................71
A.3.7 复用GPIO .......................................................................................................72

A.4 物料清单 ....................................................................................................................72
A.5 WICED配置................................................................................................................72
A.6 常见问题 ....................................................................................................................78

修订记录 82
PSoC 6 WiFi-BT Pioneer 套件指南, 文档编号: 002-28216 Rev. ** 4



安全信息
法规遵从

CY8CKIT-062-WiFi-BT PSoC® 6 WiFi-BT Pioneer 套件旨在用作实验室环境中硬件和软件的开发平

台。该电路板是一个开放系统设计，没有外壳保护。因此，在很近距离接触中，可能会对其他电器和
电气设备造成干扰。在居住环境中，该产品可能会导致无线干扰。这时，用户需要采取适当的防护措
施。同样，不要在医疗设备或 RF 器件附近使用该电路板。

增加连接到该产品的连线或修改该产品的默认设置可能会影响它的性能，并对周围近距离的设备造成
干扰。如果检测到该类干扰，应采取适当措施降低干扰。

通用安全说明

ESD 保护

ESD 会损坏电路板和相关组件。赛普拉斯建议用户在 ESD 工作站环境中操作。如果没有 ESD 工作站

可用，在对器件进行操作时，请采取适当的ESD保护措施：戴上一个连接到接地金属物的防静电手环。

操作电路板

PSoC 6 WiFi-BT Pioneer 套件对 ESD 十分敏感。只能握着电路板的边缘。从盒子里取出电路板后，

请将其放在一个接地而无静电的平面上。如果可能，请使用一个导电泡沫焊盘。请勿将该电路板在平
面上滑动。

PSoC 6 WiFi-BT Pioneer 套件包含静电放电 (ESD) 敏感器件。静电电荷很容易会在人体

或所有设备上累积，并且瞬间释放。高能量放电可能会对设备造成永久性损害。建议采
取适当的 ESD 预防措施，以避免降低其性能或丧失功能。未使用的 PSoC 6 WiFi-BT
Pioneer 套件应该被存放在保护性运输包装里。

过期时间 / 产品回收

从盒子背面显示的制造日期算起，该套件的有效期为五年。请联系离您最近的回收商来处理
套件。
PSoC 6 WiFi-BT Pioneer 套件指南, 文档编号: 002-28216 Rev. ** 5



1. 简介
感谢您对 CY8CKIT-062-WiFi-BT PSoC 6 WiFi-BT Pioneer 套件的关注。PSoC 6 WiFi-BT Pioneer 套
件让您能够使用 PSoC 6 MCU 评估和开发应用程序。

PSoC 6 MCU 是赛普拉斯最新的超低功耗 PSoC，专为可穿戴设备和物联网产品 (IoT) 而设计。它是
一个可编程嵌入式片上系统，集成了 150-MHz Arm®Cortex®-M4 作为主要应用处理器，集成 100-MHz
CM0+，支持低功耗操作，高达 1 MB 闪存和 288 KB SRAM， CapSense® 触摸感应和可编程模拟和
数字外设，可实现更高的灵活性，现场调整设计，加快产品上市速度。

PSoC 6 WiFi-BT Pioneer 板提供与 Arduino™ 屏蔽的兼容性。该板具有 PSoC 6 MCU，512 Mb NOR
闪存，板载编程器 / 调试器 (KitProg2) ，2.4-GHz WLAN 和蓝牙功能模块 (CYW4343W) ，USB Type-
C 供电系统 (EZ-PD™ CCG3) ，一个五段 CapSense 滑块，两个 CapSense 按键，一个 CapSense
接近感应接头，一个 RGB LED，两个用户 LED，USB 主机和设备功能，以及一个按钮。该电路板支

持 PSoC 6 MCU 的 1.8 V 至 3.3 V 的工作电压。

CY8CKIT-062-WiFi-BT 封装包括一个 CY8CKIT-028-TFT 显示屏，包含一个 2.4 英寸 TFT 显示屏，一

个运动传感器，环境光传感器，一个 32 位音频编解码器和一个 PDM 麦克风。

这是第一款支持 PSoC 6 MCU + WiFi 应用开发的套件。要开发 PSoC 6 MCU + WiFi 应用，必须使用

WICED™Studio 6.1 或更高版本。 WICED Studio 是赛普拉斯的集成开发环境 (IDE) ，用于开发 WiFi
应用程序。如果您没有在设计中添加 WiFi，那么您可以使用 PSoC Creator™ 开  发和调试 PSoC 6
MCU 项目。 PSoC Creator 支持将您的设计导出到其他第三方固件开发工具。
PSoC 6 WiFi-BT Pioneer 套件指南, 文档编号: 002-28216 Rev. ** 6
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1.1 套件内容

CY8CKIT-062-WiFi-BT 封装包括以下组件，如 Figure 1-1 所示。

■ PSoC 6 WiFi-BT Pioneer 电路板

■ CY8CKIT-028-TFT 显示屏蔽板

■ USB Type-A 转 Type-C 线缆

■ 四根跳线 ( 每根的长度为 4 英寸 ) 

■ 两根接近感应传感器线 ( 每个的长度为 5 英寸 ) 

■ 快速入门指南

Figure 1-1.  套件内容

检查该套件的内容时，如果您发现缺少任何器件，请联系离您最近的赛普拉斯销售办事处以获得帮助：
www.cypress.com/support。
PSoC 6 WiFi-BT Pioneer 套件指南, 文档编号: 002-28216 Rev. ** 7
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1.2 硬件简介

1.2.1 CY8CKIT-062-WiFi-BT 板详细信息

Pioneer 板如 Figure 1-2 所示，具有以下特性：

■ PSoC6 MCU

■ 与 Arduino Uno 3.3-V 屏蔽1 和 Digilent®Pmod™ 模块兼容的扩展接头

■ 型号为 1DX 超小型 2.4-GHz WLAN 和蓝牙功能模块

■ 512-Mbit 外部四 SPI NOR 闪存，为数据和代码提供快速、可扩展的存储器

■ KitProg2板载编程器 /调试器，具有大容量存储编程，USB转UART/I2C/SPI桥接功能以及定制应用

支持功能

■ EZ-PD CCG3 USB Type-C 供电 (PD) 系统，支持可充电锂离子聚合物 (Li-Po) 电池2

■ CapSense 触摸感应滑块 ( 五个元件 ) 和两个按钮，所有这些都具有自电容 (CSD) 和互电容 (CSX) 
操作，以及 CSD 接近传感器，可让您评估赛普拉斯的第四代 CapSense 技术

■ 支持PSoC 6 MCU的1.8V至3.3V工作模式。额外的330 mF超级电容用于备份域供电 (VBACKUP) 

■ 两个用户 LED，一个 RGB LED，一个用户按钮和一个用于 PSoC 6 MCU 的复位按钮。

■ KitProg2 的两个按钮和三个 LED。

1. 不支持 5-V 屏蔽。
2. 具有电池和供电功能的 USB Type-C 转 Type-C 电缆不包含在套件包中，应单独购买。
PSoC 6 WiFi-BT Pioneer 套件指南, 文档编号: 002-28216 Rev. ** 8



Figure 1-2.  Pioneer 电路板

1. USB PD 输出电压可用性指示灯 (LED7) 

2. 电池充电指示灯 (LED6) 

3. KitProg2 USB Type-C 连接器 (J10) 

4. 具有 PD 的赛普拉斯 EZ-PD™CCG3 C 型端口控制器 (CYPD3125-
40LQXI， U3) 

5. KitProg2 编程模式选择按钮 (SW3) 

6. KitProg2 I/O 接头 (J6) 1

7. KitProg2 编程 / 自定义应用程序接头 (J7) 1

8. 外部电源连接器 (J9) 

9. PSoC 6 用户按钮 (SW2) 

10. KitProg2 应用程序选择按钮 (SW4) 

11.Digilent®Pmod™ 兼容 I/O 接头 (J14) 1

12. 电源 LED (LED4) 

13. KitProg2 状态 LED (LED1， LED2 和 LED3) 

14. PSoC 6 复位按钮 (SW1) 

15. PSoC 6 I/O 接头 (J18， J19 和 J20) 

16. Arduino™Uno R3 兼容电源接头 (J1) 

17. PSoC 6 调试和跟踪接头 (J12) 

18. Arduino Uno R3 兼容的 PSoC 6 I/O 接头

 (J2， J3 和 J4) 

19. PSoC 6 程序和调试接头 (J11) 

20. CapSense 接近接头 (J13) 

21. CapSense 滑块和按钮

22. PSoC 6 VDD 选择开关 (SW5) 

23. 赛普拉斯 512-Mbit 串行 NOR 闪存

 (S25FL512S， U4) 

24. PSoC 6 用户 LED (LED8 和 LED9) 

25. RGB LED (LED5) 

26. WiFi/BT 模块 (LBEE5KL 1DX， U6) 

27. 赛普拉斯串行铁电 RAM (U5) 1

28. WiFi-BT 天线

29. VBACKUP 和 PMIC 控制选择开关 (SW7) 2

30. PSoC 6 USB 设备 Type-C 连接器 (J28) 

31. 赛普拉斯 PSoC 6 (CY8C6247BZI-D54， U1) 

32. PSoC 6 USB 主机 A 型连接器 (J27) 

33. Arduino Uno R3 兼容 ICSP 接头 (J5) 1

34. PSoC 6 电源监控跳线 (J8) 2

35. KitProg2 (PSoC 5LP) 编程器和调试器

 (CY8C5868LTI-LP039， U2) 

36. 电池连接器 (J15) 1,2

37. USB PD 输出电压 (9V/12V) 连接器 (J16) 1
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1.2.2 CY8CKIT-028-TFT 电路板详细信息

Figure 1-3 显示了具有以下功能的 TFT 显示屏蔽：

■ 2.4 英寸薄膜晶体管 (TFT) LCD 模块，分辨率为 240x320 像素。

■ 三轴加速度和三轴陀螺仪运动传感器。

■ 用于语音输入的 PDM 麦克风。

■ 32 位立体声编解码器，具有麦克风，耳机和扬声器放大器功能。

■ 一个音频插孔，提供连接 AHJ 和 OMTP 耳机。可以通过板载开关设置耳机标准。

■ 由 NPN 光电晶体管制成的环境光传感器 IC。

■ 一个 LDO，可将 3.3 V 转换为 1.8 V，用于音频编解码器的数字电源。

Figure 1-3.  TFT 显示屏

1. 2.4 英寸 TFT 显示屏

2. 运动传感器 (U1) 

3. 环境光传感器 (Q1) 

4. PDM 麦克风 (U2) 

5. Ardunio 兼容的 I/O 接头 (J2， J3， J4) 

6. Ardunio 兼容电源接头 (J1) 

7. TFT 显示屏电源控制负载开关 (U4) 

8. TFT 显示器连接器 (J5) 

9. 音频编解码器 (U3) 

10. 音频插孔 (J6) 

11. 音频插孔选择 (OMTP/AHJ) 开关 (SW1) 
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1.3 软件介绍

1.3.1 PSoC Creator 概述

PSoC Creator 是最先进、简单易用的 IDE。它包含了大量完全验证和配置的 PSoC Components™ 和

外设驱动库 (PDL) ， 从而能够协同进行革命性的硬件和软件设计，如 Figure 1-4 所示。使用 PSoC
Creator，可以执行以下操作：

1. 将组件图标拖放到主要设计工作区中，以进行硬件系统设计

2. 协作设计您的应用固件和 PSoC 硬件

3. 使用组件配置工具对各组件进行配置

4. 提供包含 100 多个组件的库

5. 查看组件数据手册

6. 导出您的设计到第三方固件开发工具。

Figure 1-4.  PSoC Creator 特性

PSoC Creator还使您能够利用集成的编译器链和PSoC器件的生产编程器进入整个工具生态系统。将

PSoC Creator 用于所有不需要 WiFi 连接的 PSoC 6 MCU 设计。如果需要 WiFi 连接，请使用 WICED
Studio 6.1 或更高版本。
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1.3.1.1 PSoC Creator 中的代码示例

PSoC Creator 包含大量代码示例。可以从 PSoC Creator Start Page 访问这些示例，如 Figure 1-5 所

示，也可以从 File > Code Example 菜单中访问。

代码示例可以通过完整的设计加速您的设计流程。代码示例还说明了如何将 PSoC Creator 组件用于

各种应用程序。包含代码示例和文档。

在 Find Code Example 对话框中，您有以下几种选择：

■ 根据器件系列或关键词筛选示例。

■ 从 Filter Options 的示例菜单中选择。

■ 查看选择的项目文档 ( 在 Documentation 选项卡上 ) 

■ 在 “Sample Code” 选项卡上查看选择的代码。您还可以将此窗口中的代码复制并粘贴到项目中，

这有助于加快代码开发速度。

■ 为代码示例创建新工作区或添加到现有工作区。这可以通过完整的基本设计加快您的设计过程。
然后，您可以根据您的应用调整该设计。

Figure 1-5.  PSoC Creator 中代码示例

1.3.1.2 套件代码示例

您可以从 PSoC Creator 起始页上访问已安装的套件代码示例。如果需要访问这些示例，首先应该扩

展 Examples and Kits 下面的 Kits，然后扩展特定套件以查看代码示例。如需了解有关访问套件代码

示例的详细信息，请参考 PSoC Creator chapter on page 18。

1.3.1.3 PSoC Creator 帮助

启动 PSoC Creator，然后导航到下列各项：

■ 速入门指南：依次选择 Help > Documentation > Quick Start Guide。本指南提供了有关开发

PSoC Creator 项目的基本知识。

■ 简单组件代码示例 : 选择File > Code Example。这些示例展示了如何配置和使用PSoC Creator组
件。要访问与特定组件相关的示例，请右键单击原理图或组件目录中的组件。在出现的上下文菜
单中选择 “Find Code Example” 选项。

■ 系统参考指南：选择 “Help > System Reference Guide”。本指南列出并描述了 PSoC Creator 提
供的系统功能。

■ 组件数据表 : 右键单击组件，然后选择 Open Datasheet。
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1.3.2 WICED Studio 开发系统概述

WICED Studio 6.1 ( 或更高版本 ) 使用 CY8CKIT-062-WiFi-BT 套件支持 WiFi 和蓝牙应用程序开发。

标签及其在 WICED IDE 中的位置如 Figure 1-6 所示。

Figure 1-6 说明了以下内容：

1. 编辑应用程序固件。

2. 帮助窗口包含有关构建和下载应用程序的说明。

3. 探索软件开发工具包 (SDK) 的现有应用程序 / 固件和库。

4. 在 “Console” 窗口中查看构建消息。

5. 为平台创建和编辑 Make Targets 以构建您的应用程序 / 项目。

Figure 1-6.  WICED IDE
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1.3.2.1 WICED Studio 代码示例

WICED Studio 包含支持蓝牙和 WiFi 平台的库和代码示例。选择 43xxx_Wi-fi Filter 将仅在项目浏览器

中显示与 WiFi 平台相关的文件，如 Figure 1-7 所示。

应用程序示例可以通过充当开发模板来加速设计过程。代码示例位于apps类别下 (在Project Explorer
窗口中 ) ，如 Figure 1-8 所示。应用程序下的代码示例进一步分为 demo， snip， test，waf (WICED
应用程序框架 ) 和 wwd (WICED WiFi 驱动程序应用程序 ) 目录。

demo 目录包含将各种 WICED 功能组合到单个应用程序中的应用程序。 snip 目录包含演示如何使用

各种 WICED 库和 API 函数的应用程序片段。 test 目录包含用于简单测试和实用程序的应用程序。

waf目录包含属于WICED应用程序框架的应用程序，例如引导加载程序。wwd目录包含使用低级 wwd
API 调用开发的应用程序，而不依赖于更高级别的 WICED API。 README.txt 位于 apps 文件夹的每

个子目录中，用于列出和汇总文件夹中的应用程序。请注意，并非所有平台都支持所有应用程序。snip
目录包含一个 README.txt，其中包含在哪些平台上支持哪些应用程序的矩阵。有关 WICED 软件堆

栈和 API 的更多详细信息，请查看 doc 文件夹 <WICED SDK 安装文件夹 > /WICED-Studio-6.1/
43xxx_Wi-Fi/doc 中提供的应用程序说明和文档。WICED-QSG.pdf，在同一路径中可用，是一个很好

的入门文档。

Figure 1-7.  WICED Studio 中代码示例筛选
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Figure 1-8.  apps 类别下代码示例

1.4 入门

本指南将帮助您熟悉 PSoC 6 WiFi-BT Pioneer 套件：

■ PSoC Creator chapter on page 18 介绍了套件软件的安装。该套件软件包括用于开发和调试应用

程序的 PSoC Creator IDE 和 PDL，和用于将 .hex 文件编程到设备上的 PSoC Programmer。

■ WICED chapter on page 24 描述了 WICED 的安装、以及该套件的基于 WICED 的示例项目的入门

指南。

■ 套件硬件 chapter on page 38介绍了CY8CKIT-062-WiFi-BT基板和CY8CKIT-028-TFT屏蔽硬件的

特性和功能。

■ 附录 on page 58 提供了详细的硬件描述、使用板载组件的方法、套件原理图、物料清单 (BOM) 和
常见问题解答。

1.5 额外学习资源

赛普拉斯在 www.cypress.com/psoc6 上提供了大量数据，可帮助您为您的设计选择合适的 PSoC 器

件，并帮助您快速有效地将器件集成到您的设计中。

1.6 技术支持

若您需要技术支持，请访问赛普拉斯支持或者致电我们公司的客户支持 +1 (800) 541-4736 选择 3 ( 美
国 ) 或 +1 (408) 943-2600 选择 3 ( 国际 ) 。

若想获得快速支持，您同样也可以使用下面的支持资源：

■ 自助 ( 技术文档 ) 

■ 所在地销售办事处
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1.7 文档规范

1.8 缩略语

Table 1-1.  指南的文档规范

规范 用途

Courier New 用于显示用户输入的文本和源代码：

Italics 用于显示文件位置规范、名称和参考文档：
阅读 PSoC Creator 的用户指南文档中的 sourcefile.hex 文件。

[ 方括号、粗体 ]
用于显示程序中的键盘指令：
[Enter] 或 [Ctrl] [C]

File > Open 表示菜单路径：
File ( 文件 )  > Open ( 打开 )  > New Project ( 新建项目 ) 

粗体字
用于操作过程中的各条指令、菜单路径和图标名称：
请点击 File 图标，然后点击 Open。

Times New Roman 字体
用于显示公式：

2 + 2 = 4

灰色框中的文本 用于说明警告或产品的独特功能。

Table 1-2.  本文档中使用的缩略语

缩略语 说明

ADC 模数转换器

BOM 物料清单

BT 蓝牙

CINT 集成电容

CMOD 调制器电容

CPU 中央处理单元

CSD CapSense sigma delta

CTANK 屏蔽槽电容

DC 直流电

Del-Sig delta-sigma

ECO 外部晶振

ESD 静电释放

F-RAM 铁电随机存取存储器

FPC 柔性印刷电路

GPIO 通用输入 / 输出

HID 人机界面设备

I2C 内部集成电路

IC 集成电路

ICSP 在线串行编程

IDAC 电流数模转换器

IDE 集成开发环境

LED 发光二极管
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PC 个人电脑

PCM 脉冲编码调制

PD 供电

PDM 脉冲密度调制

PTC 正温度系数

PSoC 可编程片上系统

PWM 脉冲宽度调制

RGB 红绿蓝

SAR 逐次逼近寄存器

SMIF 串行存储器接口

SPI 串行外设接口

SRAM 串行随机存取存储器

SWD 串行线调试

TFT 薄膜晶体管

UART 通用异步接收发射机

USB 通用串行总线

WCO 时钟晶振

Table 1-2.  本文档中使用的缩略语 (continued)

缩略语 说明
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2. PSoC Creator
本章介绍了安装 PSoC Creator 的步骤以及使用 PSoC 6 WiFi-BT Pioneer 套件所需的软件包，适用于

非 WiFi 应用。这包括将在其上构建项目并用于编程的 IDE。要开发 WiFi 应用程序，必须使用 WICED
Studio 6.1 或更高版本 ( 请参阅 WICED chapter on page 24) 。

2.1 开始之前

要安装赛普拉斯软件，您需要管理员权限。但是，运行已安装的软件时不需要这种权限。在安装套件
软件之前，请关闭当前正在运行的任何其他赛普拉斯软件。

2.2 安装套件软件

按照以下步骤安装 PSoC 6 WiFi-BT Pioneer Kit 软件：

1. 下载并运行 CY8CKIT-062-WiFi-BT PSoC 6 WiFi-BT Pioneer Kit 软件 (www.cypress.com/
CY8CKIT-062-WiFi-BT) 。该套件软件有两种不同的格式可供下载。

a. CY8CKIT-062-WiFi-BT Kit Complete Setup: 此安装包包含与套件相关的文件，包括 PSoC 
Creator， PSoC Programmer 和 PDL。但是，它不包括 Windows Installer 或 Microsoft .NET
框架包。如果您的计算机上没有这些软件包，安装程序将指示您从 Internet 下载并安装它们。

b. CY8CKIT-062-WiFi-BT Kit Only: 此可执行文件仅安装套件内容，其中包括套件代码示例，硬

件文件和用户文档。如果您的 PC 上安装了所有必备软件 ( 在步骤 3 中列出 ) ，则可以使用此

软件包。
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2. 选择要在其中安装 PSoC 6 WiFi-BT Pioneer Kit 相关文件的文件夹。选择目录并单击 “Next”。

Figure 2-1.  Kit Installer 屏幕

3. 单击 “Next” 时，安装程序会自动安装所需的软件 ( 如果您的计算机上没有该软件 ) 。以下是必需

的软件：

a. PSoC Creator 4.2: 该软件可在 www.cypress.com/psoccreator 单独下载。 PSoC Creator 4.2 
安装程序会自动安装以下附加软件：
PSoC Programmer 3.27.0 
Peripheral Driver Library 2.1.0 
Peripheral Driver Library 3.0.1 
PSoC 6 WiFi-BT Pioneer 套件指南, 文档编号: 002-28216 Rev. ** 19

www.cypress.com/psoccreator


4. 选择 Typical, Custom, 或 Complete 安装类型 ( 如果您不知道选择哪一个，请选择 Typical) ，如

Figure 2-2 所示。选择安装类型后单击 Next。

Figure 2-2.  产品按照概览

5. 阅读许可协议并选择 I accept the terms in the license agreement ( 我同意许可协议中的所有条

款 ) 以继续安装。然后点击 Next 按键。

6. 当开始进行安装时，模块列表会显示在安装页面上。每个安装成功的模块后面会显示一个绿色的
勾。

7. 请输入您的联系信息或勾选 Continue Without Contact Information ( 不提供联系信息并继续 ) 选
框。点击 Finish 按键以完成 CY8CKIT-062-WiFi-BT PSoC 6 WiFi-BT Pioneer 套件的安装。

8. 安装完成后，套件内容位于以下位置：
<Install_Directory>\CY8CKIT-062-WiFi-BT PSoC 6 WiFi-BT Pioneer Kit

默认位置：

在 Windows 操作系统 (64 位 ) 中： C:\Program Files (x86)\Cypress\CY8CKIT-062-WiFi-BT PSoC 
6 WiFi-BT Pioneer Kit

在 Windows 操作系统 (32 位 ) 中： C:\Program Files\Cypress\CY8CKIT-062-WiFi-BT PSoC 6 
WiFi-BT Pioneer Kit

注意：对于 Windows 7/8/8.1/10 用户，安装的文件和文件夹是只读的。要使用已安装的代码示例，请

在您选择的路径中创建示例的可编辑副本，以便不修改原始安装的示例。这些步骤将在您选择的路径
中创建示例的可编辑副本，因此不会修改原始安装的示例。
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2.3 使用 PSoC Creator 编程和调试

1. 使用 USB 电缆将 PSoC 6 WiFi-BT Pioneer 套件连接到 PC，如 Figure 2-3 所示。如果您是第一

次将其连接到 PC，该套件将枚举为复合设备。请参阅 4.3.3 KitProg2??????????，以了解套件

是否成功枚举。

Figure 2-3.  将 USB 线缆连接到套件上的 USB 连接器

2. 在 PSoC Creator 中打开所需的项目。为此，请选择 File > Open > Project/Workspace。这提供

了浏览和打开已保存项目的选项。

3. 选择 Build > Build Project 选项或按 [Shift] [F6] 构建项目。

4. 如果构建期间没有错误，请选择 Debug> Program 或按 [Ctrl] [F5]。它可以在 PSoC 6 WiFi-BT 
Pioneer 套件上对器件进行编程。

PSoC Creator 具有集成调试器。您可以通过选择 Debug > Debug 或按 [F5] 来启动调试器。有关更

多详细信息，请参阅 “KitProg2 用户指南 ” 中的 “ 使用 PSoC Creator 进行调试 ” 部分。

2.4 套件代码示例

PSoC 6 WiFi-BT Pioneer 套件包括两个代码示例。这两个代码示例中的一个是在 PSoC Creator 中开

发的。要访问此代码示例，请首先从 www.cypress.com/CY8CKIT-062-WiFi-BT 下载并安装 PSoC 6
WiFi-BT Pioneer Kit 安装文件。在 PC 上安装套件包之后，可以从 PSoC Creator 起始页上的 Start >
Kits 中获得基于 PSoC Creator 的代码示例。可以在以下目录中访问此代码示例：
<Install_Directory>\CY8CKIT-062-WiFi-BT PSoC 6 WiFi-BT Pioneer Kit\<version>\Firmware\PSoC 6
MCU\CE222221。

2.4.1 使用 PSoC Creator 中内置的套件代码示例

请按照以下步骤打开并使用代码示例：

1. 选择 Start > All Programs > Cypress > PSoC Creator <version> > PSoC Creator <version>
以启动 PSoC Creator。
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2. 在起始页上，单击 Start > Kits 下的 CY8CKIT-062-WiFi-BT。将出现一个代码示例列表，如

Figure 2-4 所示。

3. 单击所需的代码示例，选择要保存项目的位置，然后单击 OK。

Figure 2-4.  从 PSoC Creator 打开代码示例

4. 通过选择 Build > Build <Project Name> 来构建代码示例。构建过程成功后，将生成 .hex 文件。

5. 使用 USB 电缆将 PSoC 6 WiFi-BT Pioneer 套件连接到 PC，如 Figure 2-3 on page 21 所示，使

用代码示例对套件进行编程。

6. 在 PSoC Creator 中选择 Debug > Program。

7. 如果已经获取了器件，编程将自动完成 - 结果将显示在屏幕左下角的 PSoC Creator 状态栏中。如

果尚未获取设备，将显示 Select Debug Target 窗口。选择 KitProg2 / <serial_number>，单击

Port Acquire，如 Figure 2-5 所示。

Figure 2-5.  端口获取
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8. 获取设备后，它将显示在 KitProg2 / <serial_number> 下面的树形结构中。单击 Connect，然

后单击 OK 退出窗口并开始编程，如 Figure 2-6 所示。

注意：PSoC 6 MCU 同时具有 CM0+ 和 CM4 CPU。要进行编程，请选择其中一个并单击

Connect。要进行调试，请选择需要调试的 CPU。

Figure 2-6.  从 PSoC Creator 连接设备并编程

9. 编程成功后，代码示例即可使用。

Table 2-1 显示了在 PSoC Creator 中开发的代码示例，该示例可与此套件一起使用。

Table 2-1.  PSoC Creator 中的代码示例

项目 描述

CE222221_TFT_VoiceRecorder

此代码示例显示了如何使用 PSoC 6 MCU 录制音频数据，存储和

播放音频数据。它使用带 PDM/PCM 硬件模块的数字麦克风。麦

克风捕获的所有音频数据都存储在外部闪存中。录制完成后，您
可以通过与音频编解码器连接的 I2S 播放音频数据。您可以使用

CapSense 按钮录制 / 播放 / 暂停 / 恢复。您可以使用 CapSense
滑块控制音量。 TFT LCD 显示录音机的当前状态、音量和录音 /
播放时间。
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3. WICED
3.1 介绍

本章介绍了安装使用 PSoC 6 WiFi-BT Pioneer 套件开发 WiFi 应用程序所需的 WICED 软件工具和软

件包的步骤。本章介绍了可用于进一步开发的基于 WICED 示例项目的基本快速入门指南。

3.2 开始之前

要安装赛普拉斯软件，您需要管理员权限。但是，运行已安装的软件时不需要这种权限。在安装套件
软件之前，请关闭当前正在运行的任何其他赛普拉斯软件。

3.3 安装 WICED

CY8CKIT-062-WiFi-BT 套件需要在系统中安装 WICED 6.1 ( 或更高版本 ) 软件。WICED 6.1 需要单独

下载和安装。

1. 从 www.cypress.com/products/wiced-software 下载并安装 WICED Studio 6.1 ( 或更高版本 ) 。

2. 选择两个文件夹，一个用于 IDE，另一个用于 SDK。 SDK 文件夹包含用于开发 WiFi 应用程序的

框架。
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3. 安装程序将要求在 WiFi 和蓝牙平台之间进行选择。选择 43xxx_Wi-Fi 作为默认值。

Figure 3-1.  安装程序窗口截图

3.4 WICED 中的编程和调试

3.4.1 在 WICED Studio IDE 中为 CY8CKIT-062-WiFi-BT 构建和编程项目

要为 CY8CKIT-062-WiFi-BT 构建和编程项目，请执行以下步骤：

1. 要在 Windows PC 上打开 WICED IDE，请转到 Start > All Programs > Cypress > WICED-
Studio。

2. 在 WICED Target 选择器下拉框中选择 43xxx_Wi-Fi，如 Figure 1-7 所示。构建项目需要一个相

应的 make 目标，位于 Make Target 窗口中。所有应用程序都在 apps 目录下。 make target 路径

将包含 apps 开始的目录层次结构，目录名称以句点分隔开。项目名称后跟一个连字符，然后是平

台名称。最后，指定构建后要执行的操作，例如下载和运行。例如，要构建、下载和运行
apps\snip\scan 中存在的应用程序扫描，请创建以下 make target：

snip.scan-CY8CKIT_062 download_apps download run 

该项目将定期扫描 Wi-Fi 接入点，并使用套件上的串行转 USB 连接列出它们。

执行以下步骤以创建 make target，构建、编程和测试应用程序扫描：
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3. 在 Make Target 窗口中右键单击 43xxx_Wi-Fi，如 Figure 3-2 所示，然后单击 New。

Figure 3-2.  创建新 Make Target

4. 在 Tar  get name 字段中输入 snip.scan-CY8CKIT_062 download_apps download run，
然后单击 OK。

注意：可以在 Make target 中提供的所有命令的列表列在 <WICED-SDK 安装目录 >/43xxx_Wi-Fi/
Makefile 中。

snip.scan-CY8CKIT_062 download_apps download run 表明：

a. snip = apps 文件夹内的目录

b. scan = 要构建的应用程序的子目录和名称。例如，要在 apps 中的 test 目录下构建控制台应

用程序，请使用 test.console而不是 snip.scan。

c. CY8CKIT_062 = 电路板 / 平台名称

d. download_apps = 将应用程序资源下载到 QSPI Flash 中

e. download = 表示下载到目标

f. run = 重置目标并开始执行

5. 双击 ( 或者，右键单击并选择 Build Target) “Clean Make Target” 以删除上一版本中的任何输

出。建议在将任何新文件添加或删除到相应 Target 时进行 Make clean 操作。

注意：在执行下一步之前，请确保通过连接到 J10 端口的 Type-C USB 电缆将 CY8CKIT-062-
WiFi-BT 套件连接到同一台 PC。请参见 4.3.3 KitProg2 的套件枚举和编程模式，以确保成功枚举

套件并将 Port Selection 设置为 CMSIS-DAP 模式。
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6. 双击 ( 或者右键单击并选择 Build Target) snip.scan-CY8CKIT_062 download_apps 
download run make target 以构建并下载到 CY8CKIT-062-WiFi-BT。

该项目已构建并编程到 CY8CKIT-062-WiFi-BT 中，如 Figure 3-3 所示。

Figure 3-3.  成功构建和编程

7. 要使用终端仿真程序 ( 例如 Tera Term) 查看输出消息，请按照下列步骤操作：

a. 启动终端仿真程序。

b. 转到 Setup > Terminal，将终端 ID 设置为 VT100，将 New-Line Receive 设置为 AUTO。其

他设置应保留默认设置。
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c. 转至 Setup > Serial port，从 PC 上的设备管理器启动与串行端口号的连接。

注意：确切的端口号将随相应的 PC 端口而变化。

d. 按 CY8CKIT-062-WiFi-BT 上的 Reset 按钮查看应用程序启动消息。

8. 终端仿真程序的输出应类似于 Figure 3-4 所示。

Figure 3-4.  控制台输出
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3.4.2 使用断点调试项目

编程项目后，可以使用内置调试器在 CY8CKIT-062-WiFi-BT 中对其进行调试。

请注意，此处还使用了在在 WICED Studio IDE 中为 CY8CKIT-062-WiFi-BT 构建和编程项目 on
page 25 中使用的扫描示例。首先应在在 WICED Studio IDE 中为 CY8CKIT-062-WiFi-BT 构建和编程

项目 on page 25 列出的步骤稍作更改 ( 向 Make Target 命令添加 -debug并删除 run) 。代替

snip.scan-CY8CKIT_062 download_apps download run

应使用以下 make 命令：

snip.scan-CY8CKIT_062-debug download_apps download 

如果没有添加 -debug，那么它将被构建用于发布。调试和发布配置之间的重要区别是优化。 Debug
是在没有优化的情况下构建的，而发布是通过优化构建。不使用 -debug的情况下进行调试也是可能

的，但是如果将许多变量和行优化掉，许多断点可能不会命中。

请注意，必须在 WICED Studio 6.1 或更高版本中启动调试会话后放置断点。如果在调试会话开始之前

创建了任何断点，则必须更改其属性以便为所有线程启用。

执行以下步骤来调试项目：

1. 执行上述 make target 以将项目下载到设备。

2. 单击 Debug 图标旁边的箭头，如 Figure 3-5 所示，然后选择 43xxx-Wi-Fi_Debug_Windows。出

现 Confirm Perspective Switch 对话框 ; 单击 Yes。 Debug 会话在 start_GCC.s 文件中启动和暂

停。

注意：

a. 如果先前在 Confirm Perspective Switch 对话框中选中了 Remember my decision 复选框，

则不会再显示 “Confirm Perspective Switch 对话框。

b. 如果发生任何 MakeFile/Build 错误，则清理 ( 使用 Clean make target) ，重新构建，然后再次

下载到 CY8CKIT-062-WiFi-BT。

c. 在 Debug Perspective 中， Project 浏览器窗口默认情况下消失。要查看源文件，请切换回 “C/
C++” 透视图。
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d. 要在透视图之间切换，请使用屏幕右上角的 “C/C++” 或 “Debug” 图标。

Figure 3-5.  调试项目

3. 从 Project Explorer 窗口打开 scan.c 文件。单击带有 WPRINT_APP_INFO(("Waiting for 
scan results...\n"))的行 ; 然后按键盘上的 [Ctrl + Shift + B] 键。行号旁边会出现一个蓝

色的空心圆圈和一个复选标记，如 Figure 3-6 所示。

4. 从主菜单中，单击 Run > Resume。执行将在您添加的断点处停止。要在命中断点后继续，请再

次单击 Resume。

5. 要禁用断点，请在同一行再次按 [Ctrl + Shift + B] 键，或取消选中 Breakpoints 窗口中的相应复选

框。

注意：如果未出现 Breakpoint 窗口，请选择 Window > Show View > Breakpoints。
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6. 要终止调试会话，请单击 Run > Terminate，或单击红色方块图标。终止会话后，单击右上角的

C/C++ 以返回到 C/C++ 透视图。

Figure 3-6.  在代码中放置断点

7. 如果在启动当前调试会话之前创建了断点，则它们将不与当前线程关联，并且将使用没有复选标
记的蓝色圆圈表示。要在当前线程中启用断点，请将 Breakpoints 窗口中的属性与当前线程相关

联。

注意：如果在 Breakpoints 窗口中没有看到任何断点，请单击 Show Breakpoints Supported by 
Selected Target 图标，如 Figure 3-7 所示。断点将被显示。
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8. 右键单击所需的断点复选框，然后单击 Breakpoint Properties…。单击 last_built.elf 复选框，

如 Figure 3-8 所示。复选标记出现在实际断点之前，表示它与当前执行关联。

Figure 3-7.  显示断点图标

Figure 3-8.  为当前执行启用断点
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3.5 套件代码示例

3.5.1 在 WICED Studio IDE 中构建和编程项目

在开始使用套件代码示例之前，请确保将套件软件和 WICED 6.1 安装到您的 PC 上。安装套件软件步

骤在安装套件软件 on page 18 中进行了说明。安装 WICED on page 24 描述了 WICED 6.1 的安装。

要构建和编程 CY8CKIT-062-WiFi-BT 套件的基于 WICED 的项目，请执行以下步骤：

1. 要在 Windows PC 上打开 WICED IDE，请转到 Start > All Programs > Cypress > WICED-
Studio。

2. 在 PC 中找到 WICED WiFi-SDK 目录。默认位置为 C:\Users\<user name>\Documents\WICED-
Studio-6.1\43xxx_WiFi，如 Figure 3-9 所示。但是，根据您在安装 WICED Studio 时选择的路径，

它可能位于不同的位置。

Figure 3-9.  WICED SDK 目录

3. 此外，在 <Install_Directory>\CY8CKIT-062-WiFi-BT PSoC 6 WiFi-BT Pioneer 
Kit\<version>\Firmware\PSoC 6 MCU\CE222494_PSoC6_WICED_WiFi_Demo 位置找到

CY8CKIT-062-WiFi-BT 套件代码示例。 这有两个名为 apps 和 resources 的目录。打开

apps\demo 文件夹，将 CE222494_PSoC6_WICED_WiFi 文件夹复制到 WICED-Studio-
6.1\43xxx_Wi-Fi\apps\demo 文件夹中。
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4. 打开 resources\apps 文件夹，将 CE222494_PSoC6_WICED_WiFi 文件夹复制到 WICED-
Studio-6.1\43xxx_Wi-Fi\resources\apps。

如果使用 43xxx_Wi-Fi 作为 WICED Filter 打开 WICED Studio 6.1 ( 或更高版本 ) ，则会出现新文

件夹，如 Figure 3-10 所示。

如果项目在 WICED Studio 6.1 ( 或更高版本 ) 中不可见，则右键单击 Project Explorer 中的

43xxx_Wi-Fi 文件夹，然后单击 Refresh，如 Figure 3-10 所示。

Figure 3-10.  WICED Studio 6.1 ( 或更高版本 ) 的安装包
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Figure 3-11.  刷新 Top Folder

5. 在 Make Target 窗口中，右键单击并选择 New，并为其指定以下 Target Name：
demo.CE222494_PSoC6_WICED_WiFi-CY8CKIT_062 download_apps download run 
( 参考 Figure 3-12)。

Figure 3-12.  创建新的 Make Target
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Make Target 窗口将显示以下添加的目标
demo.CE222494_PSoC6_WICED_WiFi-CY8CKIT_062 download_apps download run (
参考 Figure 3-13)。

注意：在执行下一步之前，请确保通过连接到 J10 端口的 Type-C USB 电缆将 CY8CKIT-062-
WiFi-BT 套件连接到同一台 PC。请参见 4.3.3 KitProg2 的套件枚举和编程模式，以确保成功枚举

套件并将 Port Selection 设置为 CMSIS-DAP 模式。

6. 双击新创建的 make target 以构建代码，对工具包进行编程，然后运行示例。请注意，这可能需

要几分钟时间。

Console 窗口将显示消息 “Build Finished”，如 Figure 3-13 所示。

Figure 3-13.  构建和编程 Target

要了解关于此代码示例的更多信息，请参考 CE222494_WiFi_BT_WICED_WiFi_Demo。
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此代码示例已预编程到套件中。上电后，当您剥离 TFT 显示屏上的贴纸时，可以看到显示屏上的说

明，如 Figure 3-14 所示。

Figure 3-14.  TFT 屏幕说明显示

Table 3-1 显示了在 WICED 中开发的代码示例，该示例可与此工具包一起使用。

有关其他详细信息，请参阅 WICED 6.1 代码示例文档。

Table 3-1.  WICED 中的代码示例

项目 描述

CE222494_WiFi_BT_WICED_WiFi_Demo
此代码示例演示如何使用 PSoC 6 MCU 和 WICED 以启用 WiFi 通
信。它演示了如何将带有 4343W 模块的 PSoC 6 MCU 用作配置

接入点 (AP) ，以允许用户输入其个人网络的凭据。
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4. 套件硬件
4.1 CY8CKIT-062-WiFi-BT 详细信息

PSoC 6 WiFi-BT Pioneer 套件围绕 PSoC 6 MCU 构建 ; Figure 4-1 显示了器件的框图。有关 PSoC 6
MCU 功能的详细信息，请参见器件数据手册。

Figure 4-1.  PSoC 6 MCU 框图
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Figure 4-2 显示了 Pioneer 电路板的框图。

Figure 4-2.  Pioneer 电路板框图
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CY8CKIT-062-WiFi-BT Pioneer 套件与 PSoC 6 WiFi-BT Pioneer 板一起提供，它连接了 CY8CKIT-
028-TFT 显示屏，如 Figure 4-3 所示。

Figure 4-3.  PSoC 6 WiFi-BT Pioneer 板和 TFT 显示屏蔽

Figure 4-4 显示了 Pioneer 板的标记。

Figure 4-4.  PSoC 6 WiFi-BT Pioneer 板 – 顶视图
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PSoC 6 WiFi-BT Pioneer 板具有以下外设 :

1. USB PD 输出指示灯 (LED7) ：当 USB Type-C 电源电力传输输出可用时，此 LED 指示灯亮起。

2. 电池充电指示灯 (LED6) ：当板上电池充电器为连接到 J15 的锂离子聚合物电池充电时，此 LED
亮起。请注意，电池连接器和电池不包含在套件中，如果要测试电池充电功能，应单独购买。

3. KitProg2 USB 连接器 (J10) ：USB 电缆与 PSoC 6 WiFi-BT Pioneer 套件一起提供，连接在此

USB 连接器和 PC 之间，以使用 KitProg2 板载编程器和调试器，并为 Pioneer 板提供电源。 J10
还用于 USB Type-C 电力传输系统。有关详细信息，请参见 “EZ-PD CCG3 Type-C 电力传输 ” on 
page 56。

4. 具有 PD 的赛普拉斯 EZ-PD CCG3 Type-C 端口控制器 (CYPD3125-40LQXIT，U3) ：Pioneer 板
包括带有电力传输系统的 EZ-PD CCG3 USB Type-C 端口控制器。该器件经过预编程，可以从

Type-C 端口向板载接头 J16 供电，同时为连接到 J15 的锂离子聚合物电池充电。此外，电力传

输系统可以利用从 VIN 电源获得的电力向 Type-C 功率耗散器或消费电子 ( 例如移动电话 ) 供电。

有关详细信息，请参见 “EZ-PD CCG3 Type-C 电力传输 ” on page 56。

5. KitProg2 编程按钮 (SW3) ：此按钮可用于在 KitProg2 操作模式 ( 专有 SWD 编程 / CMSIS-DAP
模式 ) 之间切换。此按钮还可用于在自定义应用模式下为 PSoC 5LP 提供输入。有关更多详细信

息，请参阅 KitProg2 User Guide。

6. KitProg2 I/O 接头 (J6) ：该接头引出了板载 KitProg2 PSoC 5LP 器件的几个 GPIO。这包括

USB-I2C， USB-UART 和 USB-SPI 桥接线。附加的 PSoC 5LP 引脚直接连接到 PSoC 5LP 的内

部可编程模拟逻辑。您也可以将这些引脚用于自定义应用程序。有关 KitProg2 的更多详细信息，

请参阅 KitProg2 User Guide。

7. KitProg2 编程 / 自定义应用程序接头 (J7) ：该接头引出了更多 PSoC 5LP 的 GPIO，可用于自定

义应用程序。它还包含 PSoC 5LP 的 5 引脚 SWD 编程接头。

8. 外部电源 VIN 连接器 (J9) ：此连接器将外部直流电源输入连接到板载稳压器和 USB Type-C 电力

传输系统。外部电源输入的电压应介于 5 V 和 12 V 之间。此外，当用作 USB Type-C 电力传输系

统的输入时，外部电源应具有足够的电流容量，以支持通过 Type-C 端口连接的负载。有关详细

信息，请参见 “EZ-PD CCG3 Type-C 电力传输 ” on page 56。

9. PSoC 6 MCU 用户按钮 (SW2) ：该按钮可用于为 PSoC 6 MCU 提供输入。请注意，默认情况

下，该按钮在按下时将 PSoC 6 MCU 引脚接地，因此您需要将 PSoC 6 MCU 引脚配置为带电阻

上拉的数字输入，以检测按键按下。此按钮还提供来自器件的低功耗模式的唤醒源。

10. KitProg2 应用程序选择按钮 (SW4) ：此按钮可用于在 KitProg2 编程模式和自定义应用程序模式

之间切换。有关更多详细信息，请参阅 KitProg2 User Guide。

11. Digilent Pmod 兼容 I/O 接头 (J14) ：此接头可用于连接 Digilent Pmod 1 x 6 引脚模块。

12. 电源 LED (LED4) ：这是琥珀色 LED，指示 PSoC 6 MCU 的电源状态。

13. Kitprog2 状态 LED (LED1，LED2 和 LED3) ：红色，琥珀色和绿色 LED ( 分别为 LED1，LED2
和 LED3) 指示 KitProg2 的状态。有关 KitProg2 状态的更多详细信息，请参阅 KitProg2 User 
Guide。

14. PSoC 6 MCU 复位按钮 (SW1) ：该按钮用于复位 PSoC 6 MCU。它将 PSoC 6 MCU 复位 
(XRES) 引脚接地。

15. PSoC 6 MCU I/O 接头 (J18，J19 和 J20) ：这些接头提供与未连接到 Arduino 兼容接头的 PSoC 
6 MCU GPIO 的连接。这些引脚中的大多数都与板载外设复用，默认情况下不连接到 PSoC 6 
MCU。有关如何重新设置套件以访问这些引脚的详细信息，请参见 Table 4-2 on page 45。

16. Arduino 兼容电源接头 (J1) ：此接头为 Arduino 屏蔽供电。它还具有通过 VIN 输入为套件供电

的功能。
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17.PSoC 6 MCU 调试和跟踪接头 (J12) ：此接头可以连接到嵌入式跟踪宏单元 (ETM) 兼容的编程

器 / 调试器。

18. 与 Arduino Uno R3 兼容的 I/O 接头 (J2， J3 和 J4) ：这些 I/O 接头引出 PSoC 6 MCU 的引脚，

与 Arduino 屏蔽接口。其中一些引脚与板载外设复用，默认情况下不与 PSoC 6 MCU 连接。有关

如何重新设置套件以访问这些引脚的详细信息，请参见 Table 4-2 on page 45

19. PSoC 6 MCU 编程和调试接头 (J11) ：该 10 引脚接头允许您使用外部编程器 ( 如 MiniProg3) 对
PSoC 6 MCU 进行编程和调试。此外，可以将外部 PSoC 4， PSoC 5LP 或 PSoC 6 器件连接到

该接头，并使用 KitProg2 进行编程。

20. CapSense 接近接头 (J13) ：可以将一根导线连接到此接头，以评估 CapSense 的接近感应功

能。

21. CapSense 滑块 (SLIDER) 和按钮 (BTN0 和 BTN1) ：CapSense 触摸感应滑块和两个按钮，所

有这些按钮都具有自电容 (CSD) 和互电容 (CSX) 操作，可让您评估赛普拉斯 ' 第四代 CapSense
技术。滑块和按钮采用 1 毫米亚克力覆盖层，可实现平滑的触摸感应。

22. 系统电源 VDD 选择开关 (SW5) ：该开关用于选择 PSoC 6 MCU VDD 电源电压，常量 1.8 V，常

量 3.3 V，变量 1.8 至 3.3 V。 在 1.8 至 3.3 V 变量模式下， PSoC Programmer 软件可以通过

KitProg2 控制电压。

23. 赛普拉斯 512-Mbit 串行 NOR 闪存 (S25FL512S， U4) ：512Mb 容量的 S25FL512S NOR 闪存

连接到 PSoC 6 MCU 的串行存储器接口 (SMIF) 。NOR 器件可用于数据和代码存储器，支持就地

执行 (XIP) 支持和加密。

24. PSoC 6 MCU 用户 LED (LED8 和 LED9) ：这两个用户 LED 可以在 PSoC 6 MCU 的整个工作电

压范围内工作。 LED 处于低电平有效状态，因此必须将引脚接地以打开 LED。

25. RGB LED (LED5) ：此板载 RGB LED 可由 PSoC 6 MCU 控制。 LED 处于低电平有效状态，因

此必须将引脚接地以打开 LED。

26. WiFi 和蓝牙模块 (LBEE5KL1DX-883， U6) ：该套件具有板载 WiFi 和蓝牙组合模块，可演示物

联网功能。 LBEE5KL1DX 是 Type 1DX 模块，具有 2.4 GHz WLAN 和蓝牙功能。该模块基于赛

普拉斯 CYW4343W，提供高效 RF 前端电路。

27. 赛普拉斯 4 Mbit 串行铁电 RAM (FM25V10， U5) ：连接 FM25V10 或任何其他引脚兼容 F-RAM
的引脚尺寸。

28. WiFi-BT 天线 (ANT1) ：这是连接到 WiFi 和蓝牙模块的板载天线。

29. VBACKUP 和 PMIC 控制选择开关 (SW7，位于电路板底部 ) ：用于在 VDDD/KitProg2 和 Super 

Cap/PSoC 6 之间切换到 PSoC 6 MCU 的 VBACKUP 电源连接。当选择 VDDD/KitProg2 时，稳压

器开启 / 关闭由 KitProg2 控制。选择超级电容时，稳压器开启 / 关闭由 PSoC 6 MCU 控制。

30. PSoC 6 USB Type-C 连接器 (J28) ：PSoC 6 WiFi-BT Pioneer 套件随附的 USB 电缆也可以连接

在此 USB 连接器和 PC 之间，以使用 PSoC 6 MCU USB 设备应用程序。

31. 赛普拉斯 PSoC 6 MCU (CY8C6247BZI-D54， U1) ：该套件旨在突出 PSoC 6 MCU 的功能。有

关 PSoC 6 MCU 引脚映射的详细信息，请参见 Table 4-2 on page 45。

32. PSoC 6 USB Type-A 连接器 (J27) ：USB 设备可以连接到此 USB Type-A 连接器，并与 PSoC 
6 MCU USB 主机应用程序通信。

33. 与 Arduino 兼容的 ICSP 接头 (J5) ：该接头为 Arduino ICSP 兼容屏蔽提供 SPI 接口。

34. PSoC 6 MCU 电流测量跳线 (J8，位于电路板底部 ) ：电流表可以连接到该跳线，以测量 PSoC 
6 MCU 消耗的电流。

35. KitProg2 (PSoC 5LP) 编程器和调试器 (CY8C5868LTI-LP039， U2) ：PSoC 5LP 器件 
(CY8C5868LTI-LP039) 用作 KitProg2，是一个多功能系统，包括编程器，调试器， USB-I2C 桥
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接器， USB-UART 桥接器和 USB-SPI 桥接器。 KitProg2 还支持自定义应用程序。有关更多详细

信息，请参阅 “KitProg2 User Guide”。

36.电池连接器 (J15，位于电路板底部 ) ：此连接器可用于连接锂离子聚合物电池。请注意，套件包

中不包含电池，如果要演示电池充电，应单独购买。

37. USB PD 输出 (J16) ：当 USB Type-C 电力传输系统从连接到 J10 的外部主机接收电源时，此接

头提供电压输出。有关详细信息，请参见 “EZ-PD CCG3 Type-C 电力传输 ” on page 56。

有关各种硬件块的详细信息，请参见 “ 硬件功能描述 ” on page 58。

对于 PSoC 6 MCU 系列中的某些器件，同步切换具有不受限制的驱动强度和频率的 GPIO，可能会在

片上子系统中产生噪声，从而影响 CapSense 和 ADC 结果。有关更多详细信息，请参见相应器件数

据手册 (device datasheet) 的勘误表部分。

Table 4-1 显示了板载选择开关的功能。

Table 4-1.  Pioneer 板上的选择开关

开关 板上的位置 目的 默认位置

SW5 前端
选择 PSoC 6 MCU 的 VDD 电源为 1.8 V、 3.3 V，变量 1.8 V 至

3.3 V，由 KitProg2 控制。
3.3 V

SW7 后端

在 VDDD 和超级电容之间选择 PSoC 6 MCU 的 VBACKUP 电源连

接。选择 VDDD 时，可通过 KitProg2 打开 / 关闭稳压器。选择超

级电容时， PSoC 6 MCU 可以打开 / 关闭稳压器。

VDDD/KitProg2
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Figure 4-5 显示了 Pioneer 板的引脚布局

Figure 4-5.  Pioneer 板引脚布局
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Table 4-2.  Pioneer 板引脚布局

PSoC 6
引脚

主要板载功能 次要板载功能 连接详情

XRES 复位 –

P0.0 WCO IN –

P0.1 WCO OUT –

P0.2 Arduino 接头 J4.8, D7 –

P0.3 RGB 红色 LED –

P0.4 具有休眠唤醒功能的用户
按钮

–

P0.5 PMIC 控制 –

P1.0 CapSense Tx 非 Arduino 接头上
GPIO (J19.5)

填充 R174 以连接到接头或移除 R62 以断开与

CapSense 的连接

P1.1 RGB 绿色 LED –

P1.2 非 Arduino 接头上 GPIO 
(J19.4)

–

P1.3 非 Arduino 接头上 GPIO 
(J19.3)

–

P1.4 非 Arduino 接头上 GPIO 
(J19.2)

–

P1.5 桔色用户 LED
非 Arduino 接头上

GPIO (J19.1)
默认情况下连接到主要和辅助功能。移除 R27 以断

开与 LED 的连接

P2.0 SDIO DATA0
J25.7 

(WL_JTAG_TMS)
移除 R122 ( 或 R110) 并安装 R115 以断开与 PSoC 
6 的连接，并将 WiFi/BT 模块连接到 JTAG 连接器

P2.1 SDIO DATA1
J25.3 

(WL_JTAG_TDI)
移除 R32 ( 或 R111) 并安装 R116 以断开与 PSoC 6
的连接，并将 WiFi/BT 模块连接到 JTAG 连接器

P2.2 SDIO DATA2
J25.5 

(WL_JTAG_TDO)
移除 R128 ( 或 R112) 并安装 R117 以断开与 PSoC 
6 的连接，并将 WiFi/BT 模块连接到 JTAG 连接器

P2.3 SDIO DATA3
J25.1 

(WL_JTAG_TRSTN)
移除 R109 ( 或 R132) 并安装 R114 以断开与 PSoC 
6 的连接，并将 WiFi/BT 模块连接到 JTAG 连接器

P2.4 SDIO CMD –

P2.5 SDIO CLK
J25.9 

(WL_JTAG_TCK)
移除 R108 ( 或 R28) 并安装 R113 以断开与 PSoC 6
的连接，并将 WiFi/BT 模块连接到 JTAG 连接器

P3.0 BT UART TXD – WiFi/BT 模块的 BT UART TXD 引脚

P3.1 BT UART RXD – WiFi/BT 模块的 BT UART RXD 引脚

P3.2 BT UART CTS – WiFi/BT 模块的 BT UART CTS 引脚

P3.3 BT UART RTS – WiFi/BT 模块的 BT UART RTS 引脚

P3.4 BT REG ON – WiFi/BT 模块的 BT REG ON 引脚

P3.5 BT HOST WAKE – WiFi/BT 模块的 BT HOST WAKE 引脚
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P4.0 BT DEV WAKE – WiFi/BT 模块的 BT DEV WAKE 引脚

P4.1 接头 J21.1 –

P5.0
Arduino J4.1, D0

UART RX
KitProg2 UART TX

– 移除 R159 以断开与 KitProg2 UART TX 的连接

P5.1
Arduino J4.2, D1

UART TX
KitProg2 UART RX

– 移除 R156 以断开与 KitProg2 UART RX 的连接

P5.2
Arduino J4.3, D2

UART RTS
KitProg2 UART CTS

–
移除 R93 以断开与 KitProg2 UART CTS 的连接。这

也将断开与 KitProg2 的 RTS 和 SPI 线路。

P5.3
Arduino J4.4, D3

UART CTS
KitProg2 UART RTS

–
移除 R88 以断开与 KitProg2 UART CTS 的连接。这

也将断开与 KitProg2 的 RTS 和 SPI 线路。

P5.4 Arduino J4.5, D4 –

P5.5 Arduino J4.6, D5 –

P5.6 Arduino J4.7, D6 –

P5.7 接头 J21.3 –

P6.0
Arduino J3.10, SCL
KitProg2 I2C SCL

– 移除 R141 以断开与 KitProg2 I2C SCL 的连接。

P6.1
Arduino J3.9, SDA
KitProg2 I2C SDA

– 移除 R150 以断开与 KitProg2 I2C SDA 的连接

P6.2 非 Arduino 接头上 GPIO 
(J2.15)

–

P6.3 非 Arduino 接头上 GPIO 
(J2.17)

CapSense Shield
移除 R44 以断开与 GND 的连接并填充 R145 以连接

到 CapSense 屏蔽 ( 电路板上的散列图案 ) 

P6.4 TDO/SWO –

P6.5 TDI –

P6.6 TMS/SWDIO – 移除 R194 以断开与 KitProg2 SWDIO 的连接

P6.7 TCLK/SWCLK – 移除 R183 以断开与 KitProg2 SWCLK 的连接。

P7.0 TRACECLK 非 Arduino 接头上
GPIO (J18.6)

填充 R181 以连接到 J18 接头。

P7.1 CINTA –

P7.2 CINTB CSH 移除 C31 (0.47 nF) 并填充 10 nF 用于 CSH

P7.3 非 Arduino 接头上 GPIO 
(J18.5)

CSH 移除 R146 以断开与接头的连接并为 CSH 填充 C29 
(10 nF) 

P7.4 TRACEDATA[3] 非 Arduino 接头上
GPIO (J18.4)

填充 R178 以连接到 J18。

P7.5 TRACEDATA[2] 非 Arduino 接头上
GPIO (J18.3)

填充 R179 以连接到 J18。

P7.6 TRACEDATA[1] 非 Arduino 接头上
GPIO (J18.2)

填充 R180 以连接到 J18。

Table 4-2.  Pioneer 板引脚布局 (continued)

PSoC 6
引脚

主要板载功能 次要板载功能 连接详情
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P7.7 CMOD 非 Arduino 接头上
GPIO (J18.1)

填充 R142 以连接到 J18

P8.0 Proximity 非 Arduino 接头上
GPIO (J20.1)

用零欧姆填充 R64 以连接到接头

P8.1 CapSense Button0 Rx 非 Arduino 接头上
GPIO (J20.2)

移除 R61 以断开 CapSense 触控板并填充 R172 以

连接到接头

P8.2 CapSense Button1 Rx 非 Arduino 接头上
GPIO (J20.3)

移除 R60 以断开 CapSense 触控板并填充 R166 以

连接到接头

P8.3 CapSense Silder0 Rx 非 Arduino 接头上
GPIO (J20.4)

移除 R53 以断开 CapSense 触控板并填充 R153 以

连接到接头

P8.4 CapSense Silder1 Rx 非 Arduino 接头上
GPIO (J20.5)

移除 R52 以断开 CapSense 触控板并填充 R152 以

连接到接头

P8.5 CapSense Silder2 Rx 非 Arduino 接头上
GPIO (J20.6)

移除 R47 以断开 CapSense 触控板并填充 R149 以

连接到接头

P8.6 CapSense Silder3 Rx 非 Arduino 接头上
GPIO (J20.7)

移除 R58 以断开 CapSense 触控板并填充 R158 以

连接到接头

P8.7 CapSense Silder4 Rx 非 Arduino 接头上
GPIO (J20.8)

移除 R59 以断开 CapSense 触控板并填充 R160 以

连接到接头

P9.0 非 Arduino 接头上 GPIO 
(J2.2)

–

P9.1 非 Arduino 接头上 GPIO 
(J2.4)

–

P9.2 非 Arduino 接头上 GPIO 
(J2.6)

–

P9.3 TRACEDATA[0] 非 Arduino 接头上
GPIO (J2.8)

填充 R162 以连接到接头

P9.4 非 Arduino 接头上 GPIO 
(J2.10)

–

P9.5 非 Arduino 接头上 GPIO 
(J2.12)

–

P9.6 非 Arduino 接头上 GPIO 
(J2.16)

–

P9.7 非 Arduino 接头上 GPIO 
(J2.18)

–

P10.0 Arduino接头上GPIO J2.1, 
A0

–

P10.1 Arduino接头上GPIO J2.3, 
A1

–

P10.2 Arduino接头上GPIO J2.5, 
A2

–

P10.3 Arduino接头上GPIO J2.7, 
A3

–

P10.4
Arduino接头上GPIO J2.9, 

A4
 PDM_CLK

–

Table 4-2.  Pioneer 板引脚布局 (continued)

PSoC 6
引脚

主要板载功能 次要板载功能 连接详情
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P10.5
Arduino 接头上 GPIO 

J2.11, A5
PDM_DAT

–

P10.6 非 Arduino 接头上 GPIO 
(J2.13)

–

P10.7 接头 J21.5 –

P11.0 FRAM CS 非 Arduino 接头上
GPIO (J18.8)

默认情况下连接到主要和辅助功能。移除 R175 以断

开与 J18 的连接并将 R39 (10K) 加载为 FRAM 上拉

P11.1 RGB 蓝色 LED –

P11.2 QSPI FLASH CS 非 Arduino 接头上
GPIO (J18.7)

填充 R177 以连接到 J18，移除 R176 以断开与

Flash 的连接

P11.3
QSPI FLASH/
FRAM DATA3

–

P11.4
QSPI FLASH/
FRAM DATA2

–

P11.5
QSPI FLASH/
FRAM DATA1

–

P11.6
QSPI FLASH/
FRAM DATA0

–

P11.7
QSPI FLASH/
FRAM CLK

–

P12.0
Arduino J3.4, D11

SPI MOSI
ICSP 和 (J5.4) and 

Pmod 和 (J14.2)
移除 R77 以断开与 KitProg2_SPI 线路的连接

P12.1
Arduino J3.5, D12

SPI MISO
ICSP 接头 (J5.1) 和
Pmod 接头 (J14.3)

移除 R85 以断开与 KitProg2_SPI 线的连接

P12.2
Arduino J3.6, D13

SPI CLK
ICSP 接头 (J5.3) 和 
Pmod 接头 (J14.4)

移除 R81 以断开与 KitProg2_SPI 线的连接

P12.4 KitProg2 SPI SELECT 非 Arduino 接头上
GPIO (J19.10)

默认情况下连接到主要功能。填充 R74 以连接到

J19 或移除 R83 以断开 KitProg2_SPI_SELECT

P12.5 PMOD SPI SELECT, J14.1 非 Arduino 接头上
GPIO (J19.9)

默认情况下连接到主要和辅助功能。移除 R73 以断

开与 J19 的连接或移除 R82 以断开
PMOD_SPI_SELECT

P12.6 ECO IN 非 Arduino 接头上
GPIO (J19.8)

P12.7 ECO OUT 非 Arduino 接头上
GPIO (J19.6)

P13.0 Arduino接头上GPIO J3.1, 
D8

–

P13.1 Arduino接头上GPIO J3.2, 
D9

–

P13.2 USB HOST EN 非 Arduino 接头上
GPIO(J21.2)

P13.3 USB_INT_L 非 Arduino 接头上
GPIO(J21.4)

Table 4-2.  Pioneer 板引脚布局 (continued)

PSoC 6
引脚

主要板载功能 次要板载功能 连接详情
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P13.4 USB_DEV_VBUS_DET 非 Arduino 接头上
GPIO(J21.6)

P13.5 非 Arduino 接头上 GPIO 
J21.8

–

P13.6 非 Arduino 接头上 GPIO 
J2.19

CapSense shield
移除 R44 以断开与 GND 的连接并填充 R45 以连接

到 CapSense 屏蔽 ( 电路板上的散列图案 ) 

P13.7 Red user LED 非 Arduino 接头上
GPIO(J2.20)

移除 R31 以断开与 LED 的连接

Table 4-2.  Pioneer 板引脚布局 (continued)

PSoC 6
引脚

主要板载功能 次要板载功能 连接详情
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4.2 CY8CKIT-028-TFT 详细信息

4.2.1 CY8CKIT-028-TFT 显示屏蔽

Figure 4-6.  TFT 显示屏蔽

TFT 显示屏蔽具有以下外设：

1. 2.4 英寸 TFT 显示屏：这是一款 Newhaven 2.4-inch TFT LCD 模块，分辨率为 240x320 像素，

采用 Sitronix ST7789 显示控制器。该显示模块配置为 8 位并行引脚分布 (8080 系列 ) ，以与基板

上的 PSoC 6 器件连接。

2. 惯性测量单元 (U1) ：该惯性测量单元 (IMU) 是一种三轴加速度和三轴陀螺仪运动传感器，可用于

计算步数以模拟计步器或类似应用。

3. 环境光传感器 (Q1) ：这是一种高光敏 NPN 光电晶体管 IC，可用于检测环境光强度。

4. PDM 麦克风 (U2) ：此麦克风将语音输入转换为脉冲密度调制 (PDM) 数字信号。

5. 与 Arduino 兼容的 I/O 接头 (J2， J3 和 J4) ：这些接头与基板上的 PSoC 6 MCU GPIO 连接。

6. 与 Arduino 兼容的电源接头 (J1) ：该接头从电路板上的接头 J1 接收电源。

7. 电压调节器 - 1.8 V (U4) ：一个 LDO，可将 3.3 V 转换为 1.8 V，用于音频编解码器的数字电源。

8. TFT 显示器连接器 (J5) ：该连接器用于将 TFT 显示器连接到 TFT 显示屏蔽上的电路。

9. 音频编解码器 (U3) ：这是一款低功耗， 32 位立体声编解码器，带有扬声器放大器。设备的左声

道和右声道放大器输出引脚连接到板载音频插孔。

10. 音频插孔 (J6) ：板载音频插孔提供连接 AHJ 和 OMTP 耳机的功能。可以通过板载开关 SW1 设

置耳机标准。

11. 音频插孔选择开关 (SW1) ：此板载选择开关可将耳机类型设置为连接到音频插孔的 AHJ 和

OMTP 标准。
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Table 4-3.  TFT 屏蔽引脚布局

Pin # Arduino 引脚 Arduino 功能 TFT 屏蔽功能 Pioneer 板连接

J1.1 VIN VIN NC VIN

J1.2 GND GND GND GND

J1.3 GND GND GND GND

J1.4 5 V 5 V NC 5 V

J1.5 3.3 V 3.3 V VCC 3.3V 3.3 V

J1.6 RESET RESET NC SWD RESET

J1.7 I/O REF I/O REF VIO REF P6 VDD

J1.8 – – NC NC

J2.1 A0 ADC0 ALS OUT P10[0]

J2.2  – – TFT DISP DB8 P9[0]

J2.3 A1 ADC1 Codec PDN SW P10[1]

J2.4 – – TFT DISP DB9 P9[1]

J2.5 A2 ADC2 IMU INT1 P10[2]

J2.6 – – TFT DISP DB10 P9[2]

J2.7 A3 ADC3 IMU INT2 P10[3]

J2.8 – – NC P9[3]

J2.9 A4 
ADC4 / SDA 
(I2C)

PDM CLK P10[4]

J2.10 – – TFT DISP DB11 P9[4]a

a. 安装 R162 ( 在 Pioneer 板上 ) 将 TFT 板的 J2.10 连接到 P9 [4]。

J2.11 A5 ADC5 PDM DATA P10[5]

J2.12 – – TFT DISP DB12 P9[5]

J3.1 D8 DIGITAL I/O TFT DISP DB14 P13[0]

J3.2 D9 PWM TFT DISP DB15 P13[1]

J3.3 D10 SS/PWM TFT DISP RD_L P12[3]

J3.4 D11 MOSI/PWM TFT DISP WR_L P12[0]

J3.5 D12 MISO TFT DISP D/C P12[1]

J3.6 D13 SCK TFT DISP RST_L P12[2]

J3.7 GND GND GND GND

J3.8 AREF analog ref i/p NC VREF

J3.9 SDA SDA I2C SDA (IMU and audio codec) P6[1]

J3.10 SCL SCL I2C SCL (IMU and audio codec) P6[0]

J4.1 D0 RX I2S MCLK P5[0]

J4.2 D1 TX I2S TX SCK P5[1]

J4.3 D2 DIGITAL I/O I2S TX WS P5[2]

J4.4 D3 PWM, I/O I2S TX SDO P5[3]

J4.5 D4 DIGITAL I/O I2S RX SCK P5[4]

J4.6 D5 PWM, I/O I2S RX WS P5[5]

J4.7 D6 PWM, I/O I2S RX SDI P5[6]

J4.8 D7 DIGITAL I/O TFT DISP DB13 P0[2]
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Figure 4-7 显示了 TFT 显示屏蔽与 CY8CKIT-062-WiFi-BT 基板通过接头的连接

Figure 4-7.  TFT 屏蔽引脚布局

备注：

此版本的套件目前不支持1.8 V的TFT显示操作。当CY8CKIT-028-TFT显示屏蔽安装在PSoC 6 WiFi-
BT Pioneer Board 上时，请确保满足以下条件。

1. 确保将 SW5 设置为 3.3 V 或设置为 1.8 V-3.3 V VARIABLE， PSoC Programmer 或 PSoC 
Creator 选择 2.5 V 或更高的电压。

2. 如果要擦除 PSoC 6 MCU 的内部闪存，请确保当 SW5 设置为 1.8 V-3.3 V VARIABLE 位置时，

PSoC Programmer 或 PSoC Creator 设置不是 1.8 V。
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4.3 KitProg2

4.3.1 简介

PSoC 6 WiFi-BT Pioneer 套件可使用板载 KitProg2 进行编程和调试。KitProg2 是一个多功能系统，包

括编程器，调试器，USB-I2C 桥接器，USB-UART 桥接器和 USB-SPI 桥接器。KitProg2 还支持海量

存储编程和 CMSIS-DAP 以及自定义应用程序。PSoC 5LP 器件用于实现 KitProg2 功能。KitProg2 集

成在大多数 PSoC 开发套件中。有关 KitProg2 功能的更多详细信息，请参阅 KitProg2 User Guide。

在对器件进行编程之前，请确保计算机上已安装 PSoC Creator 和 PSoC Programmer 软件。有关更

多信息，请参见 “ 安装套件软件 ” on page 18。

4.3.2 使用 PSoC Programmer 编程

PSoC Programmer 可用于将现有的 .hex 文件编程到 PSoC 6 WiFi-BT Pioneer 套件中。有关更多详

细信息，请参阅 KitProg2 User Guide 中的 “Programming Using PSoC Programmer” 部分。

KitProg2 固件通常不需要任何更新。如有必要，您可以使用 PSoC Programmer 软件更新 KitProg2 固

件。有关更多详细信息，请参阅 KitProg2 User Guide 中的 “Updating the KitProg2 Firmware” 部分。

4.3.3 KitProg2 的套件枚举和编程模式

PSoC 6 WiFi-BT Pioneer套件中的PSoC 5LP器件支持两种类型的编程接口 (专有SWD编程和CMSIS-
DAP 模式编程 ) 。您可以按模式选择按钮 (SW3) 在 KitProg2 SWD 和 CMSIS-DAP 模式之间切换。当

基于 SWD 的编程模式激活时，琥珀色 LED (LED2 和 LED4) 都将打开 ( 参见 Figure 4-8) 。在 CMSIS-
DAP 模式下，只有 LED 4 为 ON，LED1，LED2 和 LED3 为 OFF ( 见 Figure 4-9) 。有关 KitProg2 编

程接口的更多详细信息，请参阅 KitProg2 User Guide。

Figure 4-8.  KitProg2 SWD 编程接口
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要了解该套件是否已成功枚举，请打开 PSoC Programmer 软件并将该套件连接到 PC。检查板载 LED
的状态和 PSoC Programmer 中的 Port Selection 窗口，了解 KitProg2 编程接口，请参见 Figure 4-8
和 Figure 4-9。

Figure 4-9.  CMSIS-DAP 编程接口

请注意，如果使用 WICED 6.1 ( 或更高版本 ) 对套件进行编程，则应启用 CMSIS-DAP 编程模式。确

认成功枚举套件后，如果要通过 PSoC Creator 或 WICED 6.1 对套件进行编程，则可以关闭 PSoC
Programmer。

基于 KitProg2 的编程接口允许您使用所需的 .hex 文件对 PSoC 6 MCU 进行编程。

4.3.4 USB-UART 桥接

PSoC 6 WiFi-BT Pioneer 套件上的 KitProg2 可用作 USB-UART 桥接器。 PSoC 6 MCU 和 KitProg2
之间的 UART 和流量控制线在板上硬连线，如 Figure 4-10 所示。有关 KitProg2 USB-UART 功能的更

多详细信息，请参阅 KitProg2 User Guide。

Figure 4-10.  KitProg2 和 PSoC 6 之间的 UART 连接
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4.3.5 USB-I2C 桥接

KitProg2 可用作 USB-I2C 桥接器，并与桥接控制面板 (BCP) 软件通信。PSoC 6 MCU 上的 I2C 线路

在板上硬连线到 KitProg2 的 I2C 线路，带有板载上拉电阻，如 Figure 4-11 所示。 USB-I2C 支持 50
kHz、100 kHz、400 kHz 和 1 MHz 的 I2C 速度。有关 KitProg2 USB-I2C 功能的更多详细信息，请参

阅 KitProg2 User Guide。

Figure 4-11.  KitProg2 和 PSoC 6 之间 I2C 连接

4.3.6 USB-SPI 桥接

KitProg2 可用作 USB-SPI 桥接器。PSoC 6 MCU 与 KitProg2 之间的 SPI 线路硬连线，如 Figure 4-12
所示。有关 KitProg2 USB-SPI 功能的更多详细信息，请参阅 KitProg2 User Guide。

Figure 4-12.  KitProg2 和 PSoC 6 之间 SPI 连接
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4.4 EZ-PD CCG3 Type-C 电力传输

Pioneer 板包括赛普拉斯 EZ-PD CCG3 电力传输系统。EZ-PD CCG3 经过预编程，可以从 Type-C 端

口向板载接头 J16 ( 称为消费者路径 ) 供电，同时为连接到 J15 的 3.7V 锂离子聚合物电池充电。此

外，电力传输系统可以利用从 VIN (J9) 电源 ( 称为提供者路径 ) 获得的电力向诸如移动电话的 Type-C
外设供电。请注意，要使用 EZ-PD CCG3 Type-C 电力传输系统，应将具有 USB Type-C 到 Type-C
电缆的电力传输线连接到 J10。该电缆不包含在套件中，应单独购买。

Figure 4-13.  Type-C 框图
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电力传输系统的工作原理如下：

1. 如果电力传输系统检测到非 Type-C 电源适配器 ( 传统 USB) ， CCG3 将以 100 mA 为电池充电。

CCG3 还将禁用使用者和提供者路径。

2. 在检测到 Type-C 电源适配器时，CCG3 将要求 3 A 5 V，3 A 9 V，或者 3 A 12 V，具体取决于主

机功能。在成功协商电平之后，通过接通负载开关 U13 来启用用户路径。此负载开关由硬件限

制，可通过插头 J16 向外部设备提供高达 1 A 的电流。 CCG3 将使用剩余电流为连接到 J15 的电

池充电，充电速率高达 1.5 A， PD 输出电压可用性指示灯 (LED7) 将打开。

3. 如果能够提供这些电压中的任何一个的直流电源连接在 VIN (J9) ， CCG3 还会宣称它可以提供 5 
V， 9 V 或 12 V。在这种情况下，电流限制为 1A。请注意，外部电源必须能够提供此电流。如果

连接的 Type-C 设备请求电源，则通过打开负载开关 U31 启用提供程序路径。 Table 4-4 详细介绍

了板载 CCG3 的电源传输方案。

有关使用 CCG3 设备的 USB Type-C 电力传输的更多信息，请参阅 EZ-PD CCG3 网页。

Table 4-4.  Type-C 电力传输场景

USB 主机 / 消费者能力 VIN 消费者能力 提供者能力
外部 USB PD 输出 

(J16 Header) 电池充电电流

非 Type-C 电源适配器 (

传统 USB)

<5 V N/A  0 0 100 mA

>5 V N/A  0 0 0

Type-C, PD 电源适配器 

(12-V capable)a

a. 该表仅在首先连接 Type-C 电缆然后应用 VIN 时有效。 如果首先应用 VIN，则消费者能力将为 N/A。

<12 V 12 V@3A  0 12 V@1Ab

b. 由于串联组件中电压降低，当使用 12 V PD 电源适配器时， J16 的电压为 ~9 V。

1.5A max 

>12 V N/A  0 0 0

Type-C, 能够提供最大 9 

Va

<9 V 9 V@3A  0 9 V@1A 1.5A max

>9 V N/A  0 0 0

只能 Type-C , 能够提供最

大 5 Va

<5 5 V@3A  0 5 V@1A 1.5A max

>5 N/A  0 0 0

Type-C, 请求 12 Va
≠ 12 V  0 5 V@1A 0 0

12 V  0 12 V@1A 0 0

Type-C, r 请求 9 Va
≠ 9 V  0 5 V@1A 0 0

9 V  0 9 V@1A 0 0

Type-C, 请求 5 Va
≠ 5 V  0 5 V@1A 0 0

5 V  0 5 V@1A 0 0

Type-C, 请求其它电压
5 V < VIN 

<12 V
 0 5 V@1A 0 0
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A. 附录
A.1 原理图

请参阅以下路径下的套件安装目录中提供的原理图文件：

■ <Install_Directory>\CY8CKIT-062-WiFi-BT PSoC 6 WiFi-BT Pioneer Kit\1.0\
Hardware\CY8CKIT-028-TFT\CY8CKIT-028-TFT Schematic.pdf

■ <Install_Directory>\CY8CKIT-062-WiFi-BT PSoC 6 WiFi-BT Pioneer Kit\1.0\
Hardware\CY8CKIT-062-WiFi-BT\CY8CKIT-062-WiFi-BT Schematic.pdf

A.2 硬件功能描述

本节介绍 PSoC 6 WiFi-BT Pioneer 板的各个硬件模块。

A.2.1 PSoC 6 MCU (U1)

PSoC 6 MCU 是赛普拉斯最新的超低功耗 PSoC，专为可穿戴设备和物联网产品而设计。它是一个可

编程嵌入式片上系统，集成了 150 MHz CM4 作为主要应用处理器， 100 MHz CM0+，支持低功耗操

作，高达 1 MB 闪存和 28 8KB SRAM，CapSense 触摸感应，和定制的模拟和数字外设功能。可编程

模拟和数字外设功能可实现更高的灵活性，设计的现场调整以及更快的上市时间。

有关更多信息，请参见 PSoC 6 MCU webpage 和 datasheet。

具有不受限制的驱动强度和频率 , 同时 GPIO 切换可能会影响 CapSense 和 ADC 性能。有关更多详细

信息，请参见相应 device datasheet 的 Errata( 勘误表 ) 部分。

A.2.2 PSoC 5LP (U2)

板载 PSoC 5LP (CY8C5868LTI-LP039) 用作 KitProg2，用于编程和调试 PSoC 6 MCU。 PSoC 5LP
通过 USB 连接器连接到 PC 的 USB 端口，并连接到 PSoC 6 MCU 的 SWD 和其他通信接口。 PSoC
5LP是一种系统级解决方案，可在单个芯片中提供MCU、存储器、模拟和数字外设功能。CY8C58LPxx
系列提供现代的信号采集、信号处理和控制方法，具有高精度、高带宽和高灵活性。模拟能力涵盖从
热电偶 ( 近直流电压 ) 到超声波信号的范围。

有关更多信息，请访问 PSoC 5LP webpage。另请参见 CY8C58LPxx family datasheet。
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A.2.3 PSoC 5LP 和 PSoC 6 MCU 之间的串行互连

除了用作板载编程器之外， PSoC 5LP 还可用作 USB-UART， USB-I2C 和 USB-SPI 桥接器的接口，

如 Figure A-1 所示。PSoC 5LP 的 USB 串行引脚硬连线到 PSoC 6 MCU 的 I2C/UART/SPI 引脚。这

些引脚也可用于兼容 Arduino 的 I/O 接头 ; 因此， PSoC 5LP 可用于控制带 I2C/UART/SPI 接口的

Arduino 屏蔽。

Figure A-1.  编程和串行接口连接的原理图
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A.2.4 EZ-PD CCG3 供电系统

赛普拉斯 EZ-PD CCG3 提供完整的解决方案，非常适用于电源适配器，移动电源， Type-C 加密狗，

显示器，底座和笔记本电脑。有关 Pioneer 电路板上电源传输系统实施的更多详细信息，请参见 EZ-
PD CCG3 Type-C 电力传输 on page 56。

Figure A-2.  EZ-PD CCG3 供电系统原理图
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Figure A-3.  EZ-PD CCG3 使用两个 CY8CKIT-062-WiFi-BT 套件的供电系统设置

A.2.5 供电系统

该电路板上的电源系统功能多样，允许输入电源来自以下来源：

■ 板载 USB Type-C 连接器提供 5 V、 9 V 或 12 V 电压

■ Arduino 屏蔽提供 5 V 至 12 V 电源，或通过 VIN 插头 J9 或 J1 从外部电源供电

■ 来自连接到 J15 的可充电锂电池的 3.7 V 电压

■ 来自连接到 J11 和 J12 的外部编程器 / 调试器的 5 V 电压

电源系统旨在支持 PSoC 6 MCU 的 1.8 V 至 3.3 V 操作。此外，功率输送电路和 KitProg2 的操作需要

5V 的中间电压。因此，三个稳压器用于实现 1.8 V 至 3.3 V 和 5 V 输出 - 降压升压调节器 (U30) ，从

5 V 至 12 V 输入产生固定的 5 V 电压，以及一个主稳压器 (U10) 产生可选 1.8 V 至 3.3 V，或固定 1.8
V，或 U30 输出固定 3.3 V。Figure A-4 显示了电压调节器和功率选择电路的原理图。除此之外，电池

充电器 U19 还可用作升压调节器。 U19 提升电池电压，为主调节器 U10 提供 5 V 电压。仅当 VIN 和

USB 电源不可用时才启用此功能。

通过开关 SW5 进行电压选择。此外，板载 330-mF 超级电容 (C103) 可用于为 PSoC 6 MCU 的备份

域 (VBACKUP) 供电。开关 SW7 选择 VDDD 和超级电容之间的 PSoC 6 MCU 的 VBACKUP 电源连

接。选择 VDDD 时，可变调节器 ON/OFF 端子由 KitProg2 控制。选择超级电容时，稳压器 ON/OFF

端子由 PSoC 6 MCU 控制。为确保 PSoC 6 MCU 正常工作，选择超级电容时必须由 PSoC 6 MCU 在

内部充电，然后再关闭稳压器。有关 PSoC 6 MCU 备份系统和电源的更多详细信息，请参见 PSoC 62
Architecture Technical Reference Manual。
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Table A-1 详细介绍了 Pioneer 板的不同供电方案 .

Table A-1.  供电方案

电源输入 电路板状况

USB VIN ETM 接头 
(VTARG_IN) 连接电池

JTAG/SWD 接

头 
(VTARG_REF)

主稳压器电
源

PSoC 电源 电池充电

非 Type-C 电

源适配器 ( 传
统 USB), 5 V

<5 N/A Yes N/A Type-C 主稳压器 100 mA

>5 N/A N/A N/A VIN 主稳压器 No

Type-C, PD
电源适配器

< PD 电源

适配器
N/A Yes N/A Type-C 主稳压器 1.5A

> PD 电源

适配器 , 
<12 V

N/A N/A N/A VIN 主稳压器 No

0 V 5 V–12 V N/A N/A N/A VIN 主稳压器 No

0 V 0 V 5 V N/A N/A
ETM 

(VTARG_IN) 主稳压器 No

0 V 0 V 0 V 3.2 V–4.2 V N/A 电池 主稳压器 No

0 V 0 V 0 V 0 V 1.8 V–3.3 V N/A
JTAG/SWD 
(VTARG_RE

F)
No
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Figure A-4.  供电系统原理图
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A.2.6 扩展连接器

A.2.6.1 Arduino 兼容接头 (J1， J2， J3， J4 和 J5) 

该板有五个与 Arduino 兼容的接头：J1，J2，J3，J4 和 J5 ( 默认情况下不填充 J5) 。您可以连接 3.3-
V Arduino 兼容屏蔽，以开发基于屏蔽硬件的应用。请注意，不支持 5 V 屏蔽，连接 5 V 屏蔽可能会

永久损坏电路板。有关 PSoC 6 MCU 引脚映射到这些接头的详细信息，请参见 Table 4-2 on page 45。

A.2.6.2 PSoC 6 MCU I/O 接头 (J18, J19, 和 J20)

这些接头提供与未连接到 Arduino 兼容接头的 PSoC 6 MCU GPIO 的连接。这些引脚中的大多数都与

板载外设复用，默认情况下不与 PSoC 6 MCU 连接。有关如何重新设置套件以访问这些引脚的详细信

息，请参阅 PSoC 6 WiFi-BT Pioneer 板修改 on page 69。

A.2.6.3 PSoC 5LP GPIO 接头 (J6)

J6 是电路板上提供的 8x2 接头，用于引出 PSoC 5LP 的多个引脚，以支持低速示波器和低速数字逻辑

分析仪等高级功能。此接头还包含 USB-UART，USB-I2C 和 USB-SPI 桥接引脚，当 Arduino 接头上

无法访问这些引脚时，可以使用该引脚，因为已连接屏蔽。附加的 PSoC 5LP 引脚直接连接到 PSoC
5LP 的内部可编程模拟逻辑。此接头还具有 GPIO, 用于自定义应用程序使用。默认情况下不会填充

J6。请注意，这些接头上的 SPI， RTS 和 CTS 线路直接来自 PSoC 5LP ( 电平转换器之前 ) 。

A.2.6.4 KitProg2 自定义应用程序接头 (J7)

电路板上提供了一个 5x2 接头，可以引出更多 PSoC 5LP GPIO，以便自定义应用程序使用。该接头

还引出 PSoC 5LP 编程引脚，可使用 MiniProg3 和五引脚编程连接器进行编程。默认情况下不会填充

J7。
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A.2.7 CapSense 电路

CapSense 滑块和两个按钮均支持自电容 (CSD) 和互电容 (CSX) 感应， CSD 接近传感器 ( 接头 ) 连
接到 PSoC 6 MCU，如 Figure A-5 所示。Pioneer 板上有四个外部电容 - 用于 CSD 的 CMOD 和 CSH，

用于 CSX 的 CINTA 和 CINTB。请注意，默认情况下不加载 CSH。有关使用 CapSense ( 包括设计

指南 ) 的详细信息，请参阅 Getting Started with CapSense Design Guide。

Figure A-5.  CapSense 电路原理图

A.2.8 LED

LED1， LED2 和 LED3 ( 分别为红色，琥珀色和绿色 ) 表示 KitProg2 状态 ( 有关详细信息，请参阅

KitProg2 User Guide) 。LED4 ( 琥珀色 ) 表示 PSoC 6 MCU 的供电状态。LED7 ( 绿色 ) 表示 J16 上

的电力传输输出状态。 LED6 ( 红色 ) 表示电池充电器状态。

Pioneer 板还具有两个用户可控 LED (LED8 和 LED9) 和一个 RGB LED (LED5) ，连接到 PSoC 6
MCU 引脚，用于用户应用。
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A.2.9 按压按钮

PSoC 6 WiFi-BT Pioneer 套件有一个复位按钮和三个用户按钮：

■ 复位按钮 (SW1) 连接到 PSoC 6 MCU 的 XRES 引脚，用于复位器件。

■ 用户按钮 (SW2) 连接到 PSoC 6 MCU 的引脚 P0 [4]。通过更改零电阻可将 (SW2) 更改为高电平有

效模式，如下图所示。

■ 其余两个按钮 - SW3和SW4分别连接到PSoC 5LP器件，用于编程模式和自定义应用程序选择 (有
关详细信息，请参阅 KitProg2 User Guide) 。

默认情况下，所有按钮在激活时均为接地 ( 低电平有效 ) 。

A.2.10 赛普拉斯 NOR 闪存

Pioneer 主板具有 512 Mb 容量的赛普拉斯 NOR 闪存 (S25FL512SAGMFI011) 。 NOR 闪存连接到

PSoC 6 MCU 的串行存储器接口 (SMIF) 。 NOR 闪存设备可用于数据和代码存储器，具有就地执行

(XIP) 支持和加密功能。
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A.2.11 WiFi 和蓝牙模块

Pioneer 板具有板载 WiFi 和蓝牙组合模块，可演示无线通信功能。该 LBEE5KL1DX 是 1DX 型模块，

具有 2.4GHz WLAN 和蓝牙功能。该模块基于赛普拉斯 CYW4343W，提供高效 RF 前端电路。
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A.2.12 USB 主机和 USB 设备连接

PSoC 6 MCU 可配置为 USB 主机或 USB 设备。将 PSoC 6 编程为主机控制器时，可以将外接设备 
( 如鼠标、键盘和闪存 ) 连接到 USB Type-A 插座端口 (J27) 。当 PSoC 6 MCU 编程为 USB 设备时，

您可以通过 USB Type-C 连接器 (J28) 上的 Type-C 电缆将套件连接到 PC 或其他主机控制器
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A.3 PSoC 6 WiFi-BT Pioneer 板修改

A.3.1 编程和调试接头上的旁路保护电路 (J11)

10 引脚接头允许您使用外部编程器 ( 如 MiniProg3) 对 PSoC 6 MCU 进行编程和调试。该接头具有保

护电路，可切断 VTARG_REF 引脚上大于 3.4 V 的任何电压。这是为了确保 PSoC 6 MCU 和其他 3.3
V 器件不会因过压而损坏。

如果外部编程器提供略高的电压，例如 3.42 V，并且您仍然需要使用编程器，则可以通过填充旁路零

欧姆电阻 R196 来旁路该保护电路。

请注意，当使用外部电源时，此更改将危及保护电路，如果外部电压超过器件的绝对最大限制，则会
对任何 3.3 V 器件造成永久性损坏。有关绝对最大电压限制，请参见相应的器件数据手册。

注意：

1. 如果使用连接到 J11 的 MiniProg3 对 PSoC 6 MCU 进行编程，请确保将电压设置为 2.5 V 或 3.3 
V。
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2. 如果要在 1.8 V 条件下使用 MiniProg3 对 PSoC 6 MCU 进行编程，请确保在电路板上填充 0 欧姆

电阻 R196。这是为了绕过过压保护电路，因为保护电路不允许在 1.8 V 下对器件进行编程。

3. 通过 MiniProg3 为 PSoC 6 供电有时会打开 LED4。这是由于当 J10 上没有连接 USB 设备时，从

PSoC 6 VDD 域反向传导到 VCC_3V3 域。

4. 在通过 J11 接头进行编程和调试时，请勿将 CY8CKIT-028-Display 屏蔽安装在 PSoC 6 Pioneer
板上。这会导致外部编程器产生额外负载，因此编程器可能无法为 PSoC 6 电源域供电。

A.3.2 PSoC 6 MCU 用户按键 (SW2)

默认情况下，此按钮在按下时将 PSoC 6 MCU 引脚连接到地，您需要将 PSoC 6 MCU 引脚配置为带

有电阻上拉的数字输入，以检测按键按下。如果要在 PSoC 6 MCU 引脚上检测到高电平有效，则应移

除电阻 R67 并填充 R68。这将连接按下时将 PSoC 6 MCU 引脚连接到 VBACKUP 的按钮。此外，还

提供了上拉和下拉电阻的封装，如果需要外部上拉，可以填充这些电阻。

A.3.3 SWD 连接器插座 (J29)

该连接器可用于导电测量，也可用于连接外部天线。默认情况下不加载。移除 L1，填充 L13 和 SWD
连接器 (J29) 以连接外部天线。有关推荐的部件号，请参见 BOM。

A.3.4 CapSense 屏蔽

CapSense 按钮和滑块周围的阴影图案接地。如果需要耐水，则需要将此图案连接到屏蔽引脚。该模

式可以分别连接到由 R138 或 R137 填充的两个端口 P6.3 或 P13.6 中的任何一个。在这两种情况下，

需要去除将阴影图案连接到地的电阻器 R44。这些引脚需要配置为 PSoC Creator 中的屏蔽引脚。

将阴影图案连接到屏蔽而不是接地也将减少传感器的寄生电容。
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A.3.5 CSH

屏蔽槽电容 (CSH) 默认不填充。该电容是可选的，当使用 CSD 感应时，可用于改进的屏蔽电极驱动

器。您可以删除 R146 以从端口断开端口 7.3 并为 CSH 填充 C29 (10 nF) 。请参阅物料清单 (BOM)
以获取建议的部件号。

A.3.6 锂电池充电器

默认情况下不加载用于锂离子聚合物电池充电器的电池连接器 (J15) ; 这需要填充以评估电池充电和

电池供电选项。请参阅 BOM 以获取推荐的部件号。推荐的锂离子聚合物速率在 850 mAH 或更高时为

3.7 V。 SparkFun Electronics PRT-13854 或同等电池可以使用。
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A.3.7 复用 GPIO

某些 PSoC 6 MCU 引脚与板载外设复用，默认情况下不连接到连接器或其他辅助组件。有关访问这些

引脚所需的修改的详细信息，请参见 Table 4-2 on page 45。

A.4 物料清单

请参阅安装的套件软件中以下路径中的 BOM 文件

■ <Install_Directory>\CY8CKIT-062-WiFi-BT PSoC 6 WiFi-BT Pioneer Kit\1.0\
Hardware\CY8CKIT-062-WiFi-BT\CY8CKIT-062-WiFi-BT PCBA BOM.xlsx

■ <Install_Directory>\CY8CKIT-062-WiFi-BT PSoC 6 WiFi-BT Pioneer Kit\1.0\
Hardware\CY8CKIT-028-TFT\CY8CKIT-028-TFT PCBA BOM.xlsx

A.5 WICED 配置

本节介绍由 WICED Studio 6.1 配置的 PSoC 6 MCU 部件。本节包括以下表格：

■ 不应更改的项目

■ 应该极其谨慎地更改的项目

■ 在特定情况下可以更改的项目

■ WICED 仅在需要时配置的项目

不应更改的配置

系统时钟

名称 配置 使用目的

Clk_Slow 无分频器
为 M0+ Core 提供时钟，而且 DMA/DW。 Clk_Slow 需要与 Clk_Peri 相同，

以保证 SDIO 正确工作

外设时钟

分频器类型 分频器 # 使用目的

8 Bit 0 SDIO。请勿与其它外设共用

GPIO

端口 引脚 使用目的

2 0 SDIO

2 1 SDIO

2 2 SDIO

2 3 SDIO

2 4 SDIO

2 5 SDIO

2 6 SDIO

11 2 SMIF

11 3 SMIF

11 4 SMIF

11 5 SMIF

11 6 SMIF

11 7 SMIF
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中断

名称 数字 优先级

UDB 122 2

DW1_1 67 3

DW1_3 69 3

SMIF 142 1

不要长时间禁用中断 ; 这将对 SDIO 和 SMIF 操作产生不利的副作用。

UDBs

不应更改 UDB 配置 ; 此配置是为 SDIO 和 TFT 显示器预先配置的。

DMAs

DMA 优先级 使用目的

DW0_0 1 SDIO

DW0_2 1 SDIO

DW1_1 0 SDIO。必须是系统中最高优先级的 DMA

DW1_3 0 SDIO。必须是系统中最高优先级的 DMA

不要创建另一个长时间阻止 DW1_1 或 DW1_3 的 DMA 通道。所有其他渠道必须具有较低优先级且可抢占。

永远不要禁用 DMA。

总线访问优先级

DW1 = 0 (Highest)
DW0 = 1
CM4 = 2

CM0+ = 2
不要更改， SDIO 操作所需

SysTick

SysTick 配置为运行 CM4 时钟 (100 MHz) ，并配置为 1 毫秒运行。

Trigger Muxes

以下触发复用器用于 SDIO，不应修改 :
(TRIG10_IN_CPUSS_DW0_TR_OUT2, TRIG10_OUT_UDB_TR_DW_ACK4)
(TRIG14_IN_UDB_TR_UDB5, TRIG14_OUT_TR_GROUP0_INPUT49)
(TRIG0_IN_TR_GROUP14_OUTPUT6, TRIG0_OUT_CPUSS_DW0_TR_IN1)
(TRIG14_IN_UDB_TR_UDB0, TRIG14_OUT_TR_GROUP0_INPUT48)
(TRIG1_IN_TR_GROUP14_OUTPUT5, TRIG1_OUT_CPUSS_DW1_TR_IN3)
(TRIG14_IN_UDB_TR_UDB6, TRIG14_OUT_TR_GROUP0_INPUT47)
(TRIG1_IN_TR_GROUP14_OUTPUT4, TRIG1_OUT_CPUSS_DW1_TR_IN1)
(TRIG14_IN_UDB_TR_UDB3, TRIG14_OUT_TR_GROUP0_INPUT46)
(TRIG0_IN_TR_GROUP14_OUTPUT3, TRIG0_OUT_CPUSS_DW0_TR_IN0)
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可以更改的配置，但会产生不良副作用

注意：如果您想更改这些配置，请联系赛普拉斯技术支持。

系统时钟

名称 配置 使用目的 备注

Clk_Peri Divder = 1 所有外设的源时钟

SDIO 时钟始终是 Clk_Peri 的四分之一。

Clk_Peri 频率的任何变化都会降低 SDIO 时钟

速度，从而降低 WiFi 吞吐量。如果 SDIO 时钟

低于 6 MHz，与 CY4343W 无线电的通信将失

败。

此外，用于 UART， SPI， I2C， PWM，

CapSense， ADC 等的 WICED API 假设此时

钟为 100 MHz。因此，使用 WICED 驱动程序

时，任何更改都会导致意外行为。

Clk_Fast Divider = 1 CM4 的时钟
降低 CM4 时钟频率会降低 WiFi 吞吐量，因为

CM4 无法快速处理数据包

Clk_Hf[0]

Input: Clk_path_0 
(FLL)
Divider: 1
Frequency: 100 
MHz

为 CM4， CM0 和外设

提供时钟

Clk_Hf [0] 是 Clk_Peri， Clk_Fast 和 Clk_Slow
的根。任何更改都会降低 WiFi 吞吐量并导致

WICED 驱动程序出现意外行为

Clk_Hf[2]

Input: Clk_path_0 
(FLL)
Divider: 2
Frequency: 50 
MHz

SMIF 时钟 (QSPI) 
对此时钟的任何更改都将导致 QSPI 运行速度

变慢

FLL
Input: IMO
Output: 100 MHz

Clk_Hf[0] root 和
Clk_Hf[2]

参见 Clk_Hf[0] 和 Clk_HF[2]
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WICED 中的默认配置 ; 如果需要可以更改。

系统时钟

名称 配置 使用目的 备注

Clk_Hf[1]
Input: Clk_path_1 (PLL)

Divider: 1
Frequency: 90 MHz

为音频子系统提供时
钟

WICED 音频 API 假设此时钟配置为 90 
MHz。如果未使用 WICED 音频 API 随时

更改。如果使用 WICED 音频 API 不要更

改。

PLL
Input: IMO

Output: 90 MHz
Clk_HF[1] root 见 Clk_Hf [1] 的注释

Peripheral Clocks

分频器类型 分频器 # 使用目的 备注

8 Bit 2 CapSense
如果未使用 WICED CapSense API，请随

时更改。如果使用 WICED CapSense 
API，请勿更改。

16 bit 5
WICED STDIO 

UART
如果未使用 WICED STDIO UART，请随

意更改，否则请勿更改

GPIO

端口 引脚 使用目的 备注

5 0
WICED STDIO 

UART
如果未使用 WICED STDIO UART，请随

意更改，否则请勿更改

5 1
WICED STDIO 

UART
如果未使用 WICED STDIO UART，请随

意更改，否则请勿更改

0 3 RED LED 配置为强驱动器

1 1 Green LED 配置为强驱动器

11 1 Blue LED 配置为强驱动器

0 4 SW2 配置为上拉

8 1 CapSense 如果未使用 WICED CapSense，请随意使

用

8 2 CapSense 如果未使用 WICED CapSense，请随意使

用

8 3 CapSense 如果未使用 WICED CapSense，请随意使

用

8 4 CapSense 如果未使用 WICED CapSense，请随意使

用

8 5 CapSense 如果未使用 WICED CapSense，请随意使

用

8 6 CapSense 如果未使用 WICED CapSense，请随意使

用

8 7 CapSense 如果未使用 WICED CapSense，请随意使

用
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中断

名称 数字 优先级 备注

PDM Interrupt 140 6
如果未使用 WICED 音频 API，请随时更

改。如果使用 WICED 音频 API 不要更

改。

I2S Interrupt 139 6
如果未使用 WICED 音频 API，请随时更

改。如果使用 WICED 音频 API 不要更

改。

SAR Interrupt 138 6
如果未使用 WICED ADC API，请随时更

改。如果使用 WICED ADC API 则不要更

改。

All SCB Interrupt 41-48 6 根据需要随意更改

CSD Interrupt 49 5 根据需要随意更改

模拟路由

使用 CapSense 时，会消耗模拟路由来连接引脚。以下路由代码用于创建此 CapSense 配置：

CY_SET_REG32(CYREG_HSIOM_AMUX_SPLIT_CTL2, 0x00000030u);
CY_SET_REG32(CYREG_HSIOM_AMUX_SPLIT_CTL4, 0x00000033u);
CY_SET_REG32(CYREG_PASS_AREF_AREF_CTRL, 0x80000000u);

Table A-2.  WICED 名称和它们在 PSoC 6 中的配置和映射

WICED 名称 PSoC 资源与配置 备注

WICED_LED1 P0.3, 强驱动 连接到红色 LED

WICED_LED2 P1.1, 强驱动 连接到绿色 LED

WICED_LED3 P11.1, 强驱动 连接到蓝色 LED

WICED_BUTTON1 P0.4, 上拉 连接到 SW2

STDIO_UART
SCB5: P5.0, P5.1
8N1 115200

WICED_ADC_1

P10.0
单端 ( 负输入连接到 VSSA/2)
无符号结果
消耗 8 位分频器 #1

WICED_PWM_1

连接到 P0.3

消耗 TCPWM Block 0 Counter 1

消耗 16 bit divider #14

红色 LED

WICED_PWM_2

连接到 P1.1

消耗 TCPWM Block 0 Counter 3

消耗 16 bit divider #14

绿色 LED

WICED_PWM_3

连接到 P11.1

消耗 TCPWM Block 1 Counter 1

消耗 16 bit divider #14

蓝色 LED
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其它说明：

■ WICED 对 CapSense 的集成有限。此集成仅支持套件上的两个按钮和五元素滑块。无法调整

WICED 或更改配置。

■ Table A-2 中未提及的任何 WICED 名称未在 platform.c 文件中完全配置，因此无法正常运行。

■ WICED API 或 PDL API 均可用于配置和使用 PSoC 6 MCU 外设。为便于使用，建议使用其中一

种。对于 STDIO UART 和 AUDIO 等外设，建议使用 WICED API。

WICED_SPI_7

消耗 SCB[6]
消耗 16 bit divider #6
MOSI - P12.0
MISO - P12.1
SCLK - P12.2
SS - P12.3

WICED_I2C_4

消耗 SCB[3]
消耗 16 bit divider #3
SCL - P6.0
SDA - P6.1

WICED_UART_3

消耗 SCB[2]
消耗 16 bit divider#2
RX - P3.0
TX - P3.1
CTS - P3.2
RTS - P3.3

WICED_UART_6

消耗 SCB[5]
消耗 16 bit divider#5
RX - P5.0
TX - P5.1

用于 STDIO UART

WICED_I2S_1
WICED_I2S_2

消耗 I2S Block (I2S_1 = Write, I2S_2 = Read)
TX SCK - P5.1
TX WS - P5.2
TX_SDO - P5.3
RX_SCLK - P5.4
RX_WS - P5.5
RX_SDI - P5.6

在使用 WICED Audio API 时消耗

Table A-2.  WICED 名称和它们在 PSoC 6 中的配置和映射

WICED 名称 PSoC 资源与配置 备注
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A.6 常见问题

1. 我的电脑上没有 Type-C 连接器。我仍然可以连接并使用此套件吗？

2. 当多个电源插入时， CY8CKIT-062-WiFi-BT 如何处理电压连接？

3. 如何访问连接到板载外设的 Smart I/O 和其他 GPIO？

4. 当开关 SW7 设置为 SuperCap 位置时，为什么 RGB LED (LED5) 的红色 LED 亮起？

5. 基板上使用的三个选择开关是为了什么？

6. 板载跳线的使用目的？

7. 输入电压容差是多少？该套件是否有过压保护？

8. 为什么套件的电压限制在 3.3 V？它可以驱动外部 5 V 接口吗？

9. 在为 PSoC 6 MCU 上电时，我错误地为 Arduino 板上电。我的 PSoC 6 设备是否还能用？

10.我可以为这个套件使用什么类型的电池？

11.我错误地把电池的极性连反了，我把系统烧坏了吗？

12.我可以用这个套件为任何 Type-C 设备充电吗？

13.如何开始评估 USB Type-C 提供商和消费者功能？

14.我无法编程目标设备。

15.当我通过 J1 接头从另一个赛普拉斯套件供电时，套件是否上电？

16.CapSense 可以使用哪些额外的覆盖层？

17.什么是 Pmod？

18.这个基板能和赛普拉斯的什么类型屏蔽一起使用？

19.该套件支持哪些第三方调试器？

20.为什么我无法使用 1.8 V 的 MiniProg3 对 PSoC 6 MCU 进行编程？

21.如何将 SW2 用于 PMIC 唤醒？
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1. 我的电脑上没有 Type-C 连接器。我仍然可以连接并使用此套件吗？

是。要评估 PSoC 6 MCU 的功能，任何具有 USB 2.0 连接的 PC 都已足够。仅在评估套件的

CCG3 部分时需要 Type-C 电源适配器。

2. 当多个电源插入时， CY8CKIT-062-WiFi-BT 如何处理电压连接？

为基板供电有五种选择：Type-C USB 连接器 (J10) ，通过 VIN 连接器的外部 DC 电源 (J9/J1) ，
调试和跟踪头 (J12， VTARG_IN) ，编程和调试头 (J11) 以及锂电池接头 (J15) 。 Type-C 和 VIN
优先于其他供应选项。这些输入使用二极管进行 “ 或 ” 运算，两者之间的较高电压优先。 ORing
二极管的输出提供给降压 - 升压稳压器 (U30) ，产生恒定的 5.2 V。此输出与 ETM 电源 (J12) 进
行 “ 或 ” 运算，通常为 5 V。对于大多数实际应用，输出为 5.2 V 稳压器优先，同样作为电压调节

器 (U10) 的输入。当不存在所有上述源时，使用锂电池电压。降压调节器 (U30) 的输出与来自程

序和调试头 (J11) 的电源电压进行 “ 或 ” 运算，并且更高的电压优先。有关电压输入和输出方案的

更多详细信息，请参见 Table A-1。

3. 如何访问连接到板载外设的 Smart I/O 和其他 GPIO？

连接到板载外设的 Smart I/O ( 端口 8 和端口 9.3) 和 GPIO 与 PSoC 6 MCU I/O 接头 (J2 和 J20) 
复用。默认情况下，这些 I/O 中的一些使用串联电阻连接到板载外设。可以更改这些电阻以将这

些 I/O 路由到接头。有关需要更改的电阻列表，请参见 Table 4-2 on page 45。

4. 当开关 SW7 设置为 SuperCap 位置时，为什么 RGB LED (LED5) 的红色 LED 亮起？

如果 SuperCap 充电电压低于 1.5 V，则会出现此行为。参考此域的 I/O 将泄漏电流，在此处为

P0 [3]。在将 SW7 切换到 SuperCap 位置之前，需要在设备中启用 VBACKUP 功能。有关启用

SuperCap 充电的选项，请参阅设备 TRM 或数据表。

5. 基板上使用的三个选择开关是为了什么？

Table 4-1 on page 43 提供了有关所有两个选择开关的详细信息。

6. 板载跳线的使用目的？

跳线 J8 可用于测量 PSoC 6 MCU 的电流，而无需从电路板上拆除任何元件。可以在此跳线上连

接电流表，以测量 PSoC 6 MCU 消耗的电流。取下 J8 上的跳线，连接电流表 ( 电流表的正极端

子连接到引脚 2) ，然后通过 USB 连接器 J10 为套件供电。

7. 输入电压容差是多少？该套件是否有过压保护？

输入电压电平如下：

Table A-3.  输入电压电平

电源 典型输入电压 绝对最大值 ( 过压保护 )

USB Type-C 连接器 (J10) 4.5 V 到 12 V 15 V

VIN 连接器 (J9/J1) 5 V 到 12 V 15 V

调试和跟踪接头 (J12) 5 V 5.5 V

编程和调试接头 (J11) 1.8 V 到 3.3 V 3.6 V

锂电池连接 (J15) 3.2 V 到 4.2 V 5 V
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8. 为什么套件的电压限制在 3.3 V？它可以驱动外部 5 V 接口吗？

PSoC 6 的供电电压不超过 3.6 V。将 PSoC 6 供电提高至 3.3 V 以上会损坏芯片。您不能使用超

过 3.3 V 的电源电压驱动 I/O 系统。

9. 在为 PSoC 6 MCU 上电时，我错误地为 Arduino 板上电。我的 PSoC 6 设备是否还能用？

是。 Arduino 电源接头上的 3.3 V 和 5 V 不是输入引脚，并具有保护电路以防止电压进入电路板。

VIN 是一个输入引脚，它连接到稳压器，它的绝对最大值为 15 V。 P6.VDD 引脚没有保护，应注

意不要为该引脚提供电压。

10. 我可以为这个套件使用什么类型的电池？

推荐的锂离子聚合物额定值为 3.7 V， 850 mAH 或更高。可以使用 SparkFun Electronics PRT-
13854 或同等级电池。根据 USB 连接是传统设备还是支持 PD，锂电池充电器可以在 100 mA 或

1.5 mA 充电。

11.我错误地把电池的极性连反了，我把系统烧坏了吗？

该套件具有相关的保护电路，可保护系统免受永久性损坏。长时间连接可能会导致损坏。

12.我可以用这个套件为任何 Type-C 设备充电吗？

该套件经过编程，可通过额定电流为 1 A 的 VIN 电压进行通告。建议使用 5 V 和 12 V 器件。 VIN
需要分别为 5 V 和 12 V 才能工作。

13. 如何开始评估 USB Type-C 提供商和消费者功能？

您可以根据您要评估的功能使用任何类型的 Type-C 笔记本电脑、移动电话或 PD 适配器。作为消

费者使用时，请注意笔记本电脑等设备可能只能提供 5 V 输出，如果没有扩展坞，则可能无法支

持 9 V/12 V。要用作提供商，可以使用任何电流要求低于 1 A 的 5 V/9 V/12 V 设备。此外，赛普

拉斯还拥有自己的 USB Type-C 评估套件，可用于评估提供商和消费者功能等等。有关这些套件

的详细信息，请访问 www.cypress.com/products/usb-type-c-and-power-delivery。

14. 我无法编程目标设备。

a. 确保 SW7 处于 VDDD/KITPROG2 位置。

b. 确保没有外部设备连接到 J11。

c. 使用 KitProg2 用户指南中提到的步骤将编程器中的 KitProg2 版本更新为 1.04 或更高版本。

d. 确保 PSoC Creator 中使用的器件为 CY8C6247BZI-D54。

15. 当我通过 J1 接头从另一个赛普拉斯套件供电时，套件是否上电？

是的， J1 接头上的 VIN 引脚是电源输入 / 输出引脚，最高可支持 12 V。

16. CapSense 可以使用哪些额外的覆盖层？

CapSense 可以使用任何覆盖层 ( 最大厚度为 5 mm) ，如木材，丙烯酸和玻璃。请注意，更改覆

盖层时可能需要进行其他调试。
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17. 什么是 Pmod?

外设模块或 Pmod 接口是 Digilent 公司在 Digilent Pmod 接口规范中定义的开放标准，用于 FPGA
或微控制器的外设。有几种模块类型可供选择 - 从简单的按钮到带网络接口的更复杂模块，模数

转换器或 LCD 显示器。 Pmod 可从多家供应商处获得，例如 Diligent， Maxim Integrated，
Analog Devices 和各种业余爱好者网站。该套件仅支持 1x6 引脚 Pmod。

18. 这个基板能和赛普拉斯的什么类型屏蔽一起使用？

任何支持 3.3V 操作的 Arduino Uno 屏蔽均与此 Pioneer 板兼容。以下赛普拉斯屏蔽与该板引脚兼

容：

a. CY3280-MBR3

b. CY8CKIT-022

c. CY8CKIT-024

d. CY8CKIT-026

e. CY8CKIT-040

f. CY8CKIT-046

g. CY8CKIT-048

19. 该套件支持哪些第三方调试器？

支持多个第三方 IDE，比如 IAR 和 uVision。有关导出到这些 IDE 的所有受支持设备和过程的更

多详细信息，请参见 PSoC Creator 的 Help 菜单。

20.为什么我无法使用 1.8 V 的 MiniProg3 对 PSoC 6 MCU 进行编程？

A.3.1 编程和调试接头上的旁路保护电路 (J11) on page 69 中所示的 Program/Debug Overvoltage 
Protection ( 编程 / 调试过压保护 ) 电路不允许在 1.8 V 通过 MiniProg3 对器件进行编程。如果要

在 1.8V 条件下使用 MiniProg3 对 PSoC 6 MCU 进行编程，请确保在电路板上的 R196 处填充 0
欧姆电阻。该电阻将绕过保护电路，并允许器件在 1.8 V 下编程。确保在任何其他工作电压下都

没有填充该电阻。

21.如何将 SW2 用于 PMIC 唤醒？

SW2 连接到 PSoC 6 MCU 的 PMIC_Wakeup_In pin (P0.4)。 PMIC_Wakeup_In 引脚上的逻辑高

电平输入可以唤醒系统并启用 PMIC。有关此功能的更多详细信息，请参见 “PSoC 6 MCU 
Architecture Technical Reference Manual” 中的 “Backup” 一章。

SW2 应从外部下拉接地，以使用 PMIC 控制。此外，当按下开关时，高电平有效逻辑应将 P0.4
推到 VBACKUP 电源。但是，该套件默认配置为使用低电平有效逻辑，如 A.2.9 按压按钮 on 
page 66 中所述。此外，在 Rev04 版本的套件中， SW2 的高电平有效逻辑将 P0.4 推到

VBACKUP。因此，需要对套件进行以下重新操作才能使用 PMIC 控制功能：

■移除 R65 并填充 0Ω R66。

■移除 R67 并在 R68 处填充 10KΩ 电阻。
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